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Предисловие

Цель
Данное руководство поддерживает Вас при использовании
коммуникационных сервисов, предоставляемых коммуникационными
процессорами SIMATIC NET (Industrial Ethernet CP) для связи по SIMATIC
NET Industrial Ethernet на уровне управления и цеха.
Руководство содержит информацию по следующим темам:

• Производительность и области применения коммуникационных
сервисов

• Конфигурирование CP с пакетом конфигурирования NCM S7

• Программирование коммуникационных интерфейсов в программе
пользователя

Аудитория
Данное руководство предназначено для персонала, отвечающего за
пусконаладку, написание программ STEP 7, и сервисный персонал.

Применение руководства
Данное руководство применимо к версии 5.x пакета конфигурирования
NCM S7 и версия 5.x программного пакета STEP 7.
Данная версия руководства содержит новую информацию,
соответствующую STEP 7 и NCM S7 V5 с сервисным пакетом 3.

Дополнительная информация
Это руководство является частью пакета документации NCM S7 для
Industrial Ethernet. Следующая таблица предоставляет обзор документации.
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Название Содержание
Пример NCM S7 для
Industrial Ethernet

Основываясь на простом примере, руководство представит Вам методы
подсоединения и подключения станций SIMATIC S7 с CP к сети на
Industrial Ethernet. Пример показывает Вам, как в программе
пользователя вводятся коммуникационные вызовы, чтобы Вы могли
использовать сервисы по интерфейсу SEND/RECEIVE.
Вы узнаете, как легко создать конфигурацию для стандартных
приложений, используя STEP 7 и дополнительный пакет NCM S7.

Руководство NCM S7
для Industrial Ethernet

Руководство используется как справочник для конфигурирования и
программирования Industrial Ethernet CP.
При работе с программным обеспечением конфигурирования, Вы также
можете вызвать встроенную справку для конкретных ситуаций.

Руководство по IT–CP Руководство используется как и справочник при работе с IT-CP. В
дополнении к функциям, предоставляемыми Ethernet CP, IT–CP также
предоставляет функции для технологии Internet.

Информация о
продукте
Ethernet CP

Информация о продукте, прилагаемая к CP, содержит характеристики по
производительности CP и инструкции по установке и подсоединению.

Дополнительная информация по SIMATIC S7 и STEP 7
Следующая документация содержит дополнительную информацию о
стандартном пакете программирования STEP 7 для программируемых
логических контроллеров SIMATIC и может быть запрошена в Вашем
местном представительстве Siemens.

Темы Документация Заказной №
Базовая информация для
технического персонала,
использующего стандартный
пакет программирования STEP
7 для решения задач
управления с ПЛК S7-300/400.

STEP 7 базовые руководства
• Конфигурирование аппаратуры с

STEP 7
• Программирование с STEP 7
• Руководство для конвертации S5 в

S7
• Пример для быстрого старта

6ES7810-4CA02-8BA0

Справочные руководства
описывают языки
программирования LAD/FBD и
STL и стандартные и
системные функции в
дополнении к базовой
информации STEP 7.

STEP 7 справочные руководства
• Руководства для LAD/FBD/STL
• Стандартные и системные

функции для S7-300/400

6ES7810-4CA02-8BR0
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Доступ к встроенной справке STEP 7 и NCM S7
В интерактивной справке, Вы можете получить следующую информацию:

• Содержание, используя команду меню Help > Contents (Справка >
Содержание)

• Контекстнозависимую справку по выбранному объекту, используя
команду меню Help > Help (Справка > Справка), функциональную
клавишу F1 или знак вопроса в панели инструментов.
При этом Вы можете получить дополнительную информацию,
относящуюся к текущей теме.

• Глоссарий для всех приложений STEP 7, щелкнув по кнопке “Glossary”
(«Глоссарий»).

Пожалуйста, обратите внимание, что каждое приложение STEP 7 имеет
собственное содержание и контекстнозависимую справку.

Соглашения
Ссылки на другие руководства и документацию, показаны номером,
обрамленным слешами /.../. Эти номера соответствуют названию
руководств, приведенных в Приложении в Разделе «Список литературы».
Совет:
Это символ появится на полях, чтобы обратить Ваше внимание на
полезные советы.
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1.1 Обзор

Темы в этом разделе
Ethernet CP для SIMATIC S7 обеспечивает ряд коммуникационных
сервисов для различных задач. Этот раздел объясняет следующее:

• Типы возможных коммуникаций с Ethernet CP по Industrial Ethernet

• Как создать условия для требуемых Вам коммуникаций

• Функции, обеспечиваемые пакетом конфигурирования NCM S7 для
Industrial Ethernet

Дальнейшая информация
Дальнейшая информация доступна из следующих источников:

• При установке Ethernet CP обращайтесь, пожалуйста, к указаниям в
информации о продукте /1/, поставляемой с Ethernet CP. Она содержит
также дополнительную информацию о производительности Ethernet
CP.

• О функционировании и использовании пакета конфигурирования STEP
7, используемой для конфигурирования CP (например,
конфигурирование аппаратуры), обращайтесь, пожалуйста, к /5/ и /7/.

• Подробную информацию о использовании, построении и управлении
Industrial Ethernet Вы найдете в /10/.

• За общим введением в локальные сети с TCP/IP обращайтесь к /15/ и
/16/.
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1.2 Industrial Ethernet

Определение
Сеть Industrial Ethernet применяется в открытой системе коммуникаций
SIMATIC NET на уровне управления и производственного участка.
Физически, Industrial Ethernet - это электрическая сеть, использующая
экранированный коаксиальный кабель и витую пару, или оптическая сеть
с волоконнооптическими кабелями.
Industrial Ethernet определена в международном стандарте IEEE 802.3
(см. /10/).

Комплексные коммуникации в промышленности
Industrial Ethernet интегрируется в концепцию SIMATIC NET, что позволяет
вместе с PROFIBUS и AS–интерфейс (AS–i) комплексное подключение к
сетям уровня управления, производственного участка и периферии.

PROFIBUS
(EN 50170 Vol. 2 PROFIBUS)

AS-Interface
(AS-i, Actuator-Sensor Interface)

 Industrial Ethernet

     (IEEE 802.3)

Рисунок 1–1 Industrial Ethernet в концепции SIMATIC NET

Доступ к сети
Industrial Ethernet использует способ доступа к сети CSMA/CD (Carrier
Sense Multiple Access with Collision Detection – Множественный доступ с
контролем несущей и обнаружением коллизий), описанный в IEEE 802.3.
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1.3 Коммуникации SIMATIC S7 с Ethernet CP

Типы коммуникаций
Ethernet CP для SIMATIC S7 поддерживает следующие типы
коммуникаций в зависимости от типа CP:

Интерфейс
SEND/RECEIVE

Возможные типы коммуникаций

Коммуникации S7

S7 - 400 Ethernet CP

с

S5-совместимые
коммуникации

Транспортное
ISO

ISO-on-TCP
TCP
UDP
E-mail

Сервисы
FETCH/WRITE
(сервер)

ISO-по-TCP

через типы соединений

S7 - 300

Управление
процесом с HTML

Ethernet CP

Транспортное
ISO TCP

Рисунок 1–2 Типы коммуникаций Ethernet CP

• Коммуникации S7
Коммуникации S7 формируют простой и эффективный интерфейс
между станциями SIMATIC S7 и PG/ПК используя коммуникационные
функциональные блоки.
CP работает как “коммуникационный транслятор S7”, передавая
коммуникационные блоки по Industrial Ethernet (см. /7/). В зависимости
от типа CP Вы используете транспортное соединение ISO, соединение
ISO–по–TCP или оба типа соединений.



Коммуникации с Ethernet CP

SIMATIC NET NCM для Industrial Ethernet 1-5

• S5–совместимые коммуникации
- Интерфейс SEND/RECEIVE
В зависимости от типа CP интерфейс SEND/RECEIVE позволяет
программно–управляемую коммуникацию по сконфигурированным
соединениям от ПЛК SIMATIC S7 к другим ПЛК SIMATIC S7, ПЛК
SIMATIC S5, ПК/PG и любой другой станции.

- Сервисы FETCH/WRITE (клиент)
Сервисы FETCH/WRITE (клиент) позволяют прямой доступ к
системным областям памяти в CPU SIMATIC S7 из SIMATIC S5 или
из устройства другого производителя.

• Управление процессом с HTML
С IT–CP Вы используете поставляемые функции и страницы HTML для
опроса важных системных данных с использованием web browser (для
более подробной информации обращайтесь к руководству по IT–CP
/4/).

Коммуникационные сервисы интерфейса SEND/RECEIVE
В зависимости от типа CP доступны следующие коммуникационные
сервисы:

• Транспортное ISO
оптимизировано для высокопроизводительного применения на
отдельном участке производства

• TCP/IP для межсетевых коммуникаций с
- соединениями ISO–по–TCP (RFC 1006)
- соединениями TCP
- сервисами дейтаграмм UDP

• Передача E–mail
- ПЛК может передавать сообщения, запускаемые событиями
процесса (за более подробной информацией обращайтесь к
руководству по IT–CP).
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Коммуникационные возможности между типами устройств
Следующая таблица показывает возможные коммуникации для выше
упомянутых типов коммуникаций:

(S7-300
только как сервер)

SEND/RECEIVE

S7-300

S5-115 - 155U/HS7-400

PC

S7-300

S7/M7-400

SEND/RECEIVE SEND/RECEIVEFETCH/WRITE
SEND/RECEIVE

Коммуникации S7

SEND/RECEIVE SEND/RECEIVE

SEND/RECEIVE

SEND/RECEIVE

Управление
процессом с
HTML

FETCH/WRITE

FETCH/WRITE

FETCH/WRITE

Коммуникации S7 Коммуникации S7

Коммуникации S7
Коммуникации S7

Конфигурация и диагностика
Для подключения к сети и конфигурирования Ethernet CP Вам необходим
пакет конфигурирования NCM S7 для Industrial Ethernet.
NCM S7 для Industrial Ethernet устанавливается как дополнительный пакет
для STEP 7 и встраивается в STEP 7.
NCM S7 для Industrial Ethernet обеспечивает также расширенные
диагностические функции для различных типов коммуникаций.
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1.4 Коммуникации S7 по Industrial Ethernet

Применение
CP действует как “коммуникационный транслятор S7”, передавая функции
S7 по Industrial Ethernet (см. /7/).

Участники для коммуникаций S7
Ethernet CP поддерживает коммуникации S7 по Industrial Ethernet на
основе транспортного ISO и ISO–по–TCP для:

• PG с STEP 7 для программирования, конфигурирования и диагностики
ПЛК SIMATIC S7;

• Приложений ПК с Ethernet CP и интерфейсом к ПЛК SIMATIC S7 для
обслуживания, наблюдения и управления;

• Устройства HMI (Человеко-Машинный Интерфейс) с SIMATIC S7;

• Коммуникаций между станциями S7 с использованием
коммуникационных функциональных блоков

Ethernet

OPPC с Ethernet CP

Человеко
машинный
интерфейс

S7 - 400 S7 - 300 Ethernet CP

STEP 7
NCM S7

Сервер

PG с Ethernet CP

Клиент

Ethernet CP

M7

WAN
*

* только TCP/IP

S7 - 400 Ethernet CP

Рисунок 1–3 Коммуникации S7 по Industrial Ethernet
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Подключение станций S7 к сети
Чтобы Вы могли использовать коммуникации S7, Вы сперва должны
подключить станции S7 к сети, как показано:
1. Подсоедините CP станций SIMATIC S7, которые должны обмениваться
данными используя функции S7, к подсети Ethernet.

2. Сконфигурируйте станции через интерфейс MPI, чтобы были
загружены параметры конфигурирования аппаратуры и подключения к
сети. Для подсоединения Ethernet CP к сети следуйте инструкциям,
приведенным в Разделе 2.2.
Для работы по Industrial Ethernet Вы должны как минимум задать
MAC/Internet адрес; это известно как инициализация узла.
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1.4.1 Использование PG с STEP 7 на Industrial Ethernet

Значение / Преимущества
Эксплуатация PG с STEP 7 на Industrial Ethernet означает следующее:

• Вы можете использовать весь диапазон функций STEP 7 на Industrial
Ethernet.

• Вы можете использовать функции программирования, диагностики,
управления и контроля по Industrial Ethernet для всех модулей ПЛК
SIMATIC S7.

Предпосылки для работы PG
Эксплуатация PG возможна, если выполнены следующие предпосылки:

•  В PG должен быть установлен Ethernet CP.

•  CP задан адрес (инициализация узла).

Industrial Ethernet

S7 - 300

Создание конфигурационных
данных для каждого CP и
загрузка их в Ethernet CP

STEP 7
NCM S7

Ethernet CPS7 - 400

Ethernet CP

WAN
*

* только TCP/IP

S7 - 400

Ethernet CP

Modem /
 ISDN

WAN

Подсоединение к
Ethernet

Рисунок 1–4 NCM S7 для Industrial Ethernet - Конфигурирование Ethernet CP
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Как использовать устройства программирования (PG) на Industrial
Ethernet

Чтобы использовать PG на Industrial Ethernet, следуйте шагам,
показанным ниже:
1. Откройте диалоговое окно “Settings PG/PC Interface” (“Задание

интерфейса PG/PC”) в панели управления Windows 98/NT или
выберите Start > SIMATIC > STEP7 > Settings PC/PG Interface
(“Задание интерфейса PG/PC”)

2. Подсоедините станции SIMATIC S7, которые Вы хотите опросить из
устройства программирования, к Industrial Ethernet.

3. Задайте интерфейс на Вашем PG/ПК, в соответствии с CP,
установленном в Вашем PG (окно «Module Parameter Sets» (“Задание
параметров модуля”)), и в соответствии с подсоединением к шине
(окно “Properties” (“Свойства”)).
Для более подробной информации, используйте встроенную справку.

Когда Вы выполните эти шаги, PG (STEP 7) автоматически найдет
маршрут по Industrial Ethernet ко всем интеллектуальным модулям Вашей
станции SIMATIC S7.
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1.4.2 Использование ПК с интерфейсом S7 на Industrial
Ethernet

Значение / Преимущества
Коммуникации S7 по Industrial Ethernet поддерживают функции S7 для ПК
с Ethernet CP и интерфейс S7 к ПЛК SIMATIC S7.

Предпосылки для использования
Эксплуатация ПК возможна, если выполняются следующие предпосылки:

• На ПК:
- установлен Ethernet CP
- установлен SOFTNET S7 для Industrial Ethernet или S7–1413/WIN 98,

WIN NT, MS–DOS, Windows

• CP в станции S7 имеет MAC/Internet адрес (инициализация узла; см.
Раздел 1.4).

Как использовать коммуникации
Чтобы использовать коммуникации S7 для ПК с ПЛК SIMATIC S7,
адресуйте из Вашего приложения на ПК требуемый модуль CPU в ПЛК
SIMATIC S7.
Для более подробной информации обращайтесь к руководству по Ethernet
CP, установленному в Вашем ПК /11/.
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1.4.3 Устройства интерфейса с оператором (TD/OP) на
Industrial Ethernet

Значение / Преимущества
Коммуникации S7 по Industrial Ethernet позволяют Вам управлять и
контролировать все модули в ПЛК SIMATIC S7 используя устройства
интерфейса с оператором.

Предпосылки для использования
Эксплуатация устройств интерфейса с оператором возможна, если
выполняются следующие предпосылки:

• На устройстве HMI:
- установлен Ethernet CP
- установлен SOFTNET S7 для Industrial Ethernet или S7–1413/WIN 98,

WIN NT, MS–DOS, Windows

• CP в станции S7 имеет MAC/Internet адрес (инициализация узла; см.
Раздел 1.4).

Как использовать коммуникации
Чтобы использовать коммуникации S7, адресуйте из Вашего устройства
интерфейса с оператором требуемый модуль в ПЛК SIMATIC S7.
Для более подробной информации, обращайтесь к описанию на Ваше
устройство интерфейса с оператором.
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1.4.4 Коммуникационные функциональные блоки S7

Значение / Преимущества

Коммуникации S7 по Industrial Ethernet позволяют программно–
управляемые коммуникации между двумя станциями SIMATIC S7 в
подсети.

Предпосылки для использования
Обмен данными с использованием коммуникационных SFB возможен,
если выполняются следующие предпосылки:

• CP в станции S7 имеет MAC/Internet адрес (инициализация узла; см.
Раздел 1.4).

Как использовать коммуникации
Чтобы использовать коммуникации S7 для обмена данными между двумя
станциями SIMATIC S7, Вы в STEP 7 конфигурируете соединение. Для
более подробной информации обращайтесь к руководству по STEP 7 /5/
/7/.

Ethernet

S7 - 400

Клиент и сервер

Ethernet CP S7 - 400 Ethernet CP

Клиент и сервер

Рисунок 1–5 Коммуникации S7
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1.5 Интерфейс SEND/RECEIVE1

Применение
Используя интерфейс SEND/RECEIVE Ваша программа пользователя S7
имеет доступ к S5–совместимым коммуникациям по
сконфигурированными транспортными соединениями.
Передача данных по сконфигурированным транспортным соединениям
подходит для

• надежной передачи соседних блоков данных между двумя узлами
Ethernet с использованием
- TCP (см. /16/ /18/ /19/), ISO–по–TCP (см. /17/) или соединениями

TCP
- транспортных соединений ISO

• простой (без квитирования) передачи соседних блоков данных (сервис
дейтаграмм) между двумя узлами Ethernet с UPD (User Datagram
Protocol – Протокол пользовательских дейтаграмм) по IP.

Интерфейс SEND/RECEIVE также подходит для передачи E–mail
(обращайтесь к руководству по IT-CP /4/).
Для приложений TCP используется активная сеть с протоколом IP (см.
/19/).

Транспортные соединения ISO
Транспортное соединение ISO обеспечивает сервисы для надежной
передачи данных по сконфигурированным соединениям. Благодаря
сегментации данных может быть передано большое количество данных.
Передача особенно надежна благодаря автоматическому повторению и
дополнительному механизму проверки блоков. Коммуникационный
партнер подтверждает прием данных и передающий принимает
возвращаемое значение по интерфейсу SEND/RECEIVE.
Транспортное соединение ISO работает только по Industrial Ethernet и
оптимизировано для высокопроизводительного применения на отдельном
участке производства.

                                                          
1  Предыдущее имя интерфейса SEND-RECEIVE - транспортное соединение.
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IP (Internet Protocol)
Для межсетевой передачи данных доступны следующие сервисы для
соответствующих CP, таких как CP 443–1 TCP:

• соединение ISO–по–TCP
ISO–по–TCP предназначено для надежной передачи данных между
сетями.
Сервис ISO–по–TCP соответствует стандартному TCP/IP (Transmission
Control Protocol/Internet Protocol – Протокол Управления
Передачей/Межсетевой Протокол) с расширением RFC 1006,
соответствующему 4 уровню эталонной модели ISO (см. /17/).
RFC 1006 расширяет протокол TCP возможностью передачи блоков
данных (“сообщений”). Подразумевается, что оба партнера
поддерживают RFC 1006.
Передача особенно надежна благодаря автоматическому повторению
и дополнительному механизму проверки блоков. Коммуникационный
партнер подтверждает прием данных и передающий принимает
возвращаемое значение по интерфейсу SEND/RECEIVE.

• соединение TCP
При использовании интерфейса SEND/RECEIVE по соединениям TCP,
Ethernet CP поддерживает интерфейс “socket” (например, Winsock.dll) к
TCP/IP, присутствующий почти в каждой системе (ПК или другая
система).
TCP предназначен для надежной межсетевой передачи данных.
Сервис TCP соответствует стандартному TCP/IP см. /17/.

• соединение UDP
UDP предназначен для простой межсетевой передачи данных без
подтверждения.

Интерфейс SEND/RECEIVE
Передача данных запускается программой пользователя. Интерфейс к
программе пользователя в SIMATIC S7 обеспечивается специальными
блоками SIMATIC S7 типа FC (функции).

Участники
Интерфейс SEND/RECEIVE позволяет программно–управляемые
коммуникации по Industrial Ethernet между ПЛК SIMATIC S7 и следующими
участниками:

• ПЛК SIMATIC S7 с Ethernet CP

• ПЛК SIMATIC S5 с Ethernet CP

• ПК/PG с Ethernet CP

• Другими станциями с подключением к Industrial Ethernet
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Ethernet

PG/PC с подсоединением
к Ethernet

SIMATIC S5
с Ethernet CP

S7 - 300 Ethernet CPS7 - 400
Ethernet CP

Other station с
подсоединением
к Ethernet

WAN
Internet только TCP/IP

Маршрутизатор

Рисунок 1–6 ПЛК SIMATIC S7 с возможными коммуникационными партнерами по интерфейсу
SEND/RECEIVE
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1.6 Сервисы FETCH/WRITE (Клиент)

Применение
В дополнении к интерфейсу SEND/RECEIVE, функции FETCH/WRITE
обеспечивают дальнейшие сервисы для S5–совместимых коммуникаций
по сконфигурированным транспортным соединениям.
Интерфейс FETCH/WRITE используется главным образом для
подсоединения SIMATIC S7 к SIMATIC S5 и к другим станциям не–S7
(например, ПК).

• FETCH
Партнер по соединению (SIMATIC S5 или станция не–S7) может читать
системные данные ПЛК SIMATIC S7.

• WRITE
Партнер по соединению (SIMATIC S5 или станция не–S7) может писать
системные данные ПЛК SIMATIC S7.

С точки зрения ПЛК SIMATIC S7, это пассивные коммуникационные
функции; коммуникационный партнер инициирует установление
соединения.
Для дополнительной информации обращайтесь к руководствам для ПЛК
SIMATIC S5 или используемой Вами станции не–S7.

Типы соединений
Для доступа с функциями FETCH или WRITE в станции S7 должно
быть сконфигурировано пассивное FETCH или пассивное WRITE
соединение. Возможны следующие типы соединений:

• транспортное ISO

• ISO–по–TCP

• TCP

Управление доступом из программы пользователя
Для управления доступом используются FC-блоки AG_LOCK и
AG_UNLOCK.
Используя эти FC Вы имеете возможность координировать доступ к
системным областям для того, чтобы не появились и не были
переданы противоречивые данные.

SIMATIC S5
На станции SIMATIC S5 сконфигурированы сервисы FETCH / WRITE и
запущены используя READ ACTIVE / PASSIVE и WRITE ACTIVE /
PASSIVE.
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1.7 Подключение станций к сети с STEP 7

Конфигурирование
Чтобы станции могли обмениваться данными друг с другом, в проектах
STEP 7 должны быть сконфигурированы сети.
Конфигурирование сети или подсети включает следующие шаги:
1. Вы создаете в проекте одну подсеть или более требуемого типа.
2. Вы задаете свойства подсети. Обычно подходят значения по
умолчанию.

3. Вы “логически” подсоединяете станцию к подсети.
4. Вы устанавливаете коммуникационные соединения.

Инструменты
SIMATIC Manager предоставляет удобные инструменты для
конфигурирования и документирования сетей (также графически с
NETPRO).

Информацию о конфигурировании сетей SIMATIC S7 также содержат
раздел, описывающий конфигурирование сетей в /4/, и встроенная
система справки.
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Варианты
Для того, чтобы уметь конфигурировать сети с STEP 7, Вы должны знать
как представляются различные типы конфигураций в проекте STEP 7.
Ниже показаны типичные конфигурации для станций, подсоединенных к
сети через CP:

Вариант
(примеры)

Характеристики / Конфигурация

1 1 подсеть - 1 проект

2 Дополнительные станции SIMATIC S5 и станции других производителей

3 2 подсети или более - 1 проект

4 1 подсеть – более, чем один проект

5 Более, чем одна подсеть – более, чем один проект
6 Межсетевые соединения (ISO–по–TCP)

Эти варианты будут использованы для показа того, как в проектах STEP 7
могут быть созданы реальные конфигурации.
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1.7.1 Вариант сети/проекта: Одна подсеть - один проект

Конфигурация системы
В простейшем случае, Ваша система состоит из станций SIMATIC S7,
объединенных в одну подсеть, например, типа Industrial Ethernet.

C

C

Ethernet (1)

Установка
“Производство”

Представление в проекте STEP 7
Вы создаете в проекте STEP 7 объект Industrial Ethernet.
Станции, созданные в этом же проекте, будут относится к этому объекту
как только Вы сконфигурируете их как узлы сети

S7-400/1 S7-300/1

S7-300/2
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1.7.2 Вариант сети/проекта:
SIMATIC S5 и устройства не–SIMATIC в подсети

Конфигурация системы
В дополнении к станции SIMATIC S7 в Вашу систему могут быть включены
станции SIMATIC S5 и устройства не–SIMATIC.

C
P

C
P

Ethernet (1)

Установка
“Производство”

SIMATIC S5

не-SIMATIC

S7-400/1
S7-300/1

S7-300/2

Представление в проекте STEP 7
Станции SIMATIC S5, которые д.б. включены в коммуникацию, м.б. выбраны напрямую.
Устройства не-SIMATIC д.б. добавлены, как Other Stations (Другие станции).
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1.7.3 Вариант сети/проекта:
Две подсети или более - один проект

Конфигурация системы
Разные задачи станций или расширение системы могут потребовать
использование более одной сети.

C

PROFIBUS (1)

Ethernet (1)

C

Представление в проекте STEP 7
Вы можете создать все подсети и сконфигурировать все станции
для обмена данными в одном проекте STEP 7.

Установка
«Производство
и Управление»

S7-400/1

S7-300/1 S7-300/2

S7-400/2
PROFIBUS CP

Ethernet CP

Этот экран показывает следующее:

• В одном проекте может быть использована более чем одна подсеть.

• Каждая станция создается в проекте один раз.

• Каждая станция может быть включена в более чем одну подсеть,
назначив соответствующие CP к различным подсетям.
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1.7.4 Вариант сети/проекта:
Одна подсеть - более чем один проект

Конфигурация системы
В сложных системах, объединенных в сети, может быть более удобно
управлять станциями в более чем одном проекте.

S7 400/1

C

S7 - 300/3

Представление в пректе STEP 7
Для того, чтобы адресовать станции из других проектов (например,
“Производство 2”), они д.б. дополнительно сконфигурированы в другом
проекте (например, “Производство 1”) как Other Stations (Другие станции).

Установка
“Производство 1”

C

S7 300/1

C

S7 - 300/2

S7 - 400/2

Ethernet (1)

Установка
“Производство 2”

Этот экран показывает, что подсеть может быть назначена в нескольких
проектах.

Замечание

Соединения S7 м.б. запроектированы только в одном проекте.
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1.7.5 Вариант сети/проекта:
Две подсети или более в более чем одном проекте

Конфигурация системы
Если разные задачи станций или расширение системы могут сделать
необходимым иметь разные типы сетей, которые будут в разных проектах,
то станции из других проектов могут быть адресованы, если
сконфигурировать их как “Other stations” («Другие станции»).

C

S7 - 300/1

PROFIBUS (1)

C

S7 - 300/2

S7 - 400/1

Ethernet (1)
Уровень цеха

Уровень периферии

Ethernet CP

PROFIBUS CP
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1.7.6 Вариант сети/проекта:
Соединения между подсетями (TCP/IP)

Конфигурация системы
Если разные задачи станций или расширение системы могут сделать
необходимым подсоединение через маршрутизатор, то станции могут
быть адресованы, если сконфигурировать их как “Other stations”
(«Другие станции»).

C

S7 - 400/1

Ethernet CP

S7 - 400/2

Ethernet CP

* только TCP/IP
Маршрутизатор *

S7 - 300/1

Ethernet (1)

Ethernet (2)

WAN
Internet *

Представление в проекте STEP 7
Если станции двух сетей управляются в одном проекте,

 то в NETPRO они представляются следующим образом.
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2.1 Обзор

Темы в этом разделе
Чтобы подсоединить станцию SIMATIC с Ethernet CP к Industrial Ethernet,
сконфигурируйте CP с пакетом конфигурирования NCM S7. Это раздел
объясняет следующее:

• Как конфигурируется CP в проекте STEP 7

• Как работают с различными сетевыми конфигурациями (задание
доступа к другим системам)

• Как CP управляется и обеспечивается данными, используя NCM S7

Дополнительная информация
Дополнительная информация доступна из следующих источников:

• При установке Ethernet CP обращайтесь, пожалуйста, к указаниям в
информации о продукте /1/, поставляемой с Ethernet CP. Она содержит
также дополнительную информацию о производительности Ethernet
CP.

• Для информации о функционировании и использовании STEP 7, в
который интегрируется дополнительный пакет NCM S7, читайте,
пожалуйста, следующие темы:
- Об использовании функции справки, обращайтесь к разделу

"Работа с STEP 7" - в /5/.
- Конфигурирование модуля и назначение ему параметров - в /5/
- Конфигурирование сетей - в /5/.

Информация об установке NCM S7 и примерах конфигураций может
быть найдена в Примере /3/.
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2.2 Методика

CP в проекте STEP 7
CP управляется в проекте S7 подобно другим модулям. Для
конфигурирования аппаратуры, создания и управления программами
пользователя Вы используйте STEP 7 (см. /5/).

Шаги конфигурирования
Конфигурирование CP включает следующие базовые шаги:

Создание подсети Industrial Ethernet (см. 2.2.1)

Добавление Ethernet CP в конфигураторе аппаратуры (см. 2.2.3)

Выполнение других установок для CP (см. 2.2.5)

Конфигурирование коммуникационных служб
- Однородные коммуникации S7 /5/
- Транспортные соединения ISO (см. Раздел 4)
- Соединения ISO-по-TCP (см. Раздел 4)
- UDP (см. Раздел 4)

Загрузка конфигурации в ПЛК (см. 2.2.8).

     Конфигурационные
данные в проекте STEP 7

Проверка или задание свойства подсети (см. 2.2.2)

Подсоедините Ethernet CP к подсети Ethernet (см. 2.2.3)

Отображение подсоединения станций к сети (см. 2.2.4)

Программирование интерфейса SEND/RECEIVE
(см. Раздел 3)

Более подробно шаги объясняются в указанных разделах.
Шаги, показанные пунктирными линиями, опциональныl.
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2.2.1 Создание подсети Industrial Ethernet

Цель
Чтобы подсоединить станции SIMATIC к подсети, Вы создаете подсеть в
Вашем проекте. Это позволяет централизовано хранить все параметры,
относящиеся ко всей подсети.

Методика
Рекомендуется создать подсеть до конфигурирования станций, потому
что тогда подключение станций SIMATIC происходит почти
автоматически.
Также возможно создать подсеть позднее при конфигурировании CP.
Более подробно это объясняется позже в этом разделе.
Следуйте шагам, показанным ниже:
1. Выберите проект в SIMATIC Manager.
2. Выберите Insert > Subnet > Ethernet (Вставить > Подсеть > Ethernet).
Результат: в проекте создается объект типа сеть. Затем все станции
SIMATIC, созданные в проекте, м.б. подключены к этой подсети.

Рисунок 2–1 Проект с сетью Ethernet
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3. Если Вы предпочитаете графическое отображение сети, то выберите
сетевой объект “Ethernet” и выберите пункт меню Edit > Open Object
(Правка > Открыть объект).

Рисунок 2–2 Графическое представление сети (здесь показаны станции, уже подсоединенные к
сети)

Из этого графического представления, Вы также можете активировать все
функции подключения к сети и конфигурирования соединений с Ethernet
CP.
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2.2.2 Добавление Ethernet CP в аппаратную конфигурацию

Методика
Вставив и назначив Ethernet CP в носитель модулей станции SIMATIC, Вы
устанавливаете логическое соединение между CP и подсетью.

1. Выберите в Вашем проекте станцию, которую Вы хотите подсоединить
к Industrial Ethernet через Ethernet CP.

2. Поместите CP в таблицу конфигурации как любой другой модуль,
выбрав его из каталога аппаратуры и выбрав соответствующее
посадочное место в носителе модулей.
Вы выбираете CP из каталога аппаратуры, используя приводимое
краткое описание и заказной номер. CP появляется в каталоге и
доступен для выбора после установки NCM S7.
Результат: CP назначен к станции SIMATIC.
За информацией о разрешенных посадочных местах, обращайтесь к
/1/.
Как конфигурируется модуль подробно описано в /5/.
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2.2.3 Подсоединение станции SIMATIC к подсети Ethernet

Подсоединение к подсети
Чтобы активировать сетевое соединение Ethernet CP, после добавления
CP в аппаратную конфигурацию, следуйте шагам, показанным ниже:
1. Выберите Object Properties (Свойства объекта) выбрав пункт меню

Edit > Object Properties (Правка > Свойства объекта) или дважды
щелкнув по модулю.
Результат:

Рисунок 2–3 Пример вкладки «General» (“Общее”) диалога “Properties CP”
(“Свойства CP”) для CP 443–1 TCP

2. Введите подходящее имя для CP в поле “Name” (“Имя”) и любую
другую информацию в поле “Comment” («Комментарий»).

3. Щелкните по кнопке “Properties” (“Свойства”) в разделе “Interface”
(“Интерфейс”).
Результат: откроется вкладка “Network Connection” (“Соединение с
сетью”) диалогового окна “Properties Ethernet Nodes” (“Свойства узлов
Ethernet”).
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HelpCancel

Рисунок 2–4 Вкладка “Network Connection” (“Соединение с сетью”) диалогового окна “Properties
Ethernet Nodes” (“Свойства узлов Ethernet”)

4. Если Вы еще не создали в проекте подсеть или не создали требуемую
подсеть, то Вы можете теперь создать подсеть, щелкнув по кнопке
“New” ("Новая").
Результат: В проекте создается объект типа сеть.
Теперь следуйте шагам, показанным в Разделе 2.2.2.

5. Проверьте адрес и, если необходимо, измените его. По умолчанию
автоматически вводится следующий свободный адрес.

6. Выберите требуемую подсеть из списка “Industrial Ethernet”.
7. Вы можете отобразить диалог свойств для выбранной подсети
щелкнув по кнопке Properties (Свойства). Для более подробной
информации о диалоге свойств сети Industrial Ethernet, обращайтесь к
Разделу 2.2.2.

8. Введите любую дополнительную информацию, характеризующую
участника подсети, во вкладке "General" ("Общее").

9. Подтвердите Ваш ввод щелкнув по OK, иначе Ваше подсоединение к
сети не будет выполнено.

Результат: CP теперь сконфигурирован в станции S7 как сетевой узел.

Замечание
Поля ввода “IP Address” («IP Адреса») и “Router” (“Маршрутизатор”) в
разделе “IP Parameters” («Параметры IP») не существуют для
транспортного соединения ISO.
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2.2.4 Отображение подсоединений станций к сети

Методика
Вы можете легко получить обзор конфигурации подсоединений станции
SIMATIC к сети в виде:

•  графического обзора в NETPRO;

•  обзора в виде таблицы в диалоге свойств станции

Графический обзор в NETPRO
Представление NETPRO предоставляет Вам хороший обзор
подсоединений станций к сети:
Выполните следующее:
1. В SIMATIC Manager в Вашем проекте щелкните дважды по одному из
сетевых объектов, например, Ethernet.

Рисунок 2–5 Представление NETPRO подсети типа Industrial Ethernet
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Обзор в виде таблицы
Представление таблицы в диалоге свойств станции предоставляет
подробный обзор используемых для подсоединения к сети компонент.
Следуйте шагам, приведенным ниже:
1. В SIMATIC Manager в Вашем проекте выберите станцию, которую Вы
хотите проверить.

2. Выберите Object Properties (Свойства объекта) из меню Edit >
Object Properties (Правка > Свойства объекта) или дважды щелкнув
по значку станции.

3. Перейдите во вкладку “Network” (“Сеть”).
Результат:

HelpCancel

Рисунок 2–6 Вкладка “Network” (“Сеть”) диалога “SIMATIC 300/400”

Вы увидите сконфигурированные соединения с подсетями для станции
SIMATIC.

Вы можете использовать флажки под “Subnet Type” ("Тип подсети") для
выбора того, что будет отображаться. Ваш выбор вступит в силу после
того, как Вы щелкните по кнопке “Update” ("Обновить").
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2.2.5 Задание других свойств CP

Обзор
В дополнению к заданию сетевого соединения, Вы можете выполнить
другие, зависимые от модуля, установки или вызвать функции.
1. Выберите Ethernet CP в аппаратной конфигурации.
2. Выберите Edit > Object Properties (Правка > Свойства объекта).
Откроется диалог, содержащий вкладку "General" 
("Общее"), описанную в Разделе 2.2.4, и следующие вкладки:
- Addresses (Адреса)
- Time (Время) (не для всех типов модулей)
- Diagnostics (Диагностика)

Вкладка Addresses (Адреса)
Вкладка Addresses (Адреса) отображает адрес, по которому модуль может
быть адресован в программе пользователя. Вам потребуется этот адрес
при вызове блоков FC для транспортного соединения -> см. Раздел 5.

Вкладка Options (Параметры)
В зависимости от типа CP, Вы можете выполнить следующие установки:

• Синхронизация времени
Вы используете вкладку «Time» («Время») для задания будет ли CP
передавать кадры синхронизации времени. Вам необходима эта
функция, если в одной станции содержится более, чем один CP,
потому что сообщения синхронизации времени можно передавать
только через один CP.

• Передача данных > 240 байт
Этим параметром Вы задаете поддерживает или нет CP задания с
объемом данных более 240 байт (для станций S7–300).

Замечание
Новыми версиями CP поддерживается передача более 240 байт данных.
За более подробной информацией, обращайтесь к информации о
продукте для Вашего Ethernet CP.
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Замечание
Помните, что если Вы используйте эту конфигурацию с S7–300, то в CPU
S7–300 используется один ресурс соединения (свободное соединение для
функций S7)! Ресурсы соединения CPU также занимаются, например, при
использовании FMS CP S7-300 или устройством программирования или
OP. Для более подробной информации о максимальном количестве
ресурсов соединения, обращайтесь к /12/ и /6/.

Рисунок 2–7 Вкладка “Options” (“Параметры”) диалога ”Properties CP 443–1”
(“Свойства CP 443–1”)

Замечание
Вкладка Time существует не для всех типов модулей.

Вкладка Diagnostics (Диагностика)
Из вкладки “Diagnostics” (“Диагностика”) Вы можете запустить диагностику
NCM S7 Ethernet. Для описания диагностических функций см. Раздел 6
«Диагностика».
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2.2.6 “Замещающие объекты” в проекте STEP 7

Обзор
В проекте должны быть созданы замещающие объекты для станций, чьи
конфигурационные данные не были созданы в STEP 7 или чьи
конфигурационные данные не управляются в текущем активном проекте.
Это требуется для следующих станций на подсети Ethernet:

• Станций SIMATIC S5

• Устройств других производителей (Other Station (Другие станции))

• PG/ПК

• Станций SIMATIC S7 из другого проекта (Other Station (Другие
станции))

Замечание
Вместо создания замещающих объектов, Вы можете также
сконфигурировать незаданные соединения для соединений с выше
перечисленным станциям.
В диалоге свойств этих соединений, Вы должны задать полный адрес
партнера. Эти партнеры не отображаются в представлении NetPro.

Установка
“Производство 1”

SIMATIC S5

не-SIMATIC

S7-400/5

PC/PG

C

C

Ethernet подсеть 1

S7-400/1
S7-400/2

S7-400/3

C

S7-400/4

Установка
“Производство 2”
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Методика
Чтобы добавить в проект замещающие объекты, следуйте шагам,
приведенным ниже:
1. Выберите проект в SIMATIC Manager.
2. Выберите Insert > Station> (Вставить > Станция >) и затем Other

Station (Другая станция), PG/PC или SIMATIC S5 в зависимости от
того, что Вам нужно.
Результат: в проекте создан выбранный объект.

Рисунок 2–8 Проект с сконфигурированными замещающими объектами



Установка и запуск Ethernet CP с STEP 7

SIMATIC NET NCM для Industrial Ethernet 2-15

Подсоединение станций не–S7 к подсети
Следующий шаг - присоединение замещающих объектов к подсети, как
показано:
1. Выберите в проекте требуемый объект и выберите Edit > Object

Properties (Правка > Свойства объекта).
2. В появившемся диалоговом окне "Properties" ("Свойства"), щелкните по
кнопке "New" ("Новая") во вкладке Node List (Список узлов).
Результат: отобразиться диалоговое окно выбора типа узла.

Help
Cancel

Рисунок 2–9 Выбор типа подсети для «Other Station» (“Другой станции”) (Пример)

3. Выберите подсеть.
Результат: Появиться диалоговое окно “Properties - Ethernet Nodes"
("Свойства - Узлы Ethernet "). Здесь Вы можете выбрать подсеть,
подсоединить станцию к сети и задать адрес (MAC, IP). Все станции
SIMATIC в проекте могут установить коммуникационное соединение с
замещающим объектом.
Адреса (MAC, IP), назначенные замещающему объекту, д.б. также заданы
на реальной станции, используя соответствующие инструменты
(например, COM 1430).
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2.2.7 Конфигурирование коммуникационных служб

Установка соединений
Вы должны установить соединения для поддерживаемых Industrial
Ethernet CP сервисов, ориентированных на соединение, см. также таблицу
в Разделе 1.3.

• Соединения S7
см. руководство пользователя STEP 7 /5/

• Транспортные соединения ISO
см. Раздел 4.5

• Соединения ISO–по–TCP
см. Раздел 4.6.

• Соединения TCP
см. Раздел 4.7

• Соединения для UDP см. Раздел 4.8.
Для дополнительных типов соединений, возможных с CP, также
применима информация из руководства пользователя STEP 7 /5/ из
раздела “Конфигурирование аппаратуры и проектирование соединений”.
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2.2.8 Загрузка конфигурации в ПЛК

Принцип
Конфигурационные данные для Ethernet CP загружаются из аппаратной
конфигурации. Загружаются все конфигурационные данные станции S7,
включая центральную конфигурацию, конфигурацию всех
соответствующих DP master'у систем и все параметры.
Данные сконфигурированных соединение должны быть загружены
дополнительно, см. ниже.

Типы соединений
Вы можете загрузить конфигурационные данные в станцию S7 по MPI
соединение или по Ethernet (предварительно Вы должны выполнить
"инициализацию узла").

Инициализация узла
Во время так–называемой “ инициализации узла”, Вы назначаете Ethernet
CP адреса MAC или Internet. Инициализация узла возможна только по
MPI.
Когда Вы выполнили шаги, очерченные непрерывными линиями на блок-
схеме, приведенной в Разделе 2.2, Вы успешно сконфигурировали CP.
Теперь Вы можете провести остальные шаги конфигурирования с PG,
подключенного к Ethernet.

Методика
Чтобы загрузить конфигурационные данные в станцию S7, следуйте
шагам, показанным ниже:
1. Откройте диалоговое окно “Settings PG/PC Interface” (“Задание
интерфейса PG/ПК”) в панели управления Windows 98/NT.

2. Задайте интерфейс на Вашем PG/ПК, в соответствии с CP,
установленном в Вашем PG (окно «Module Parameter Sets» (“Задание
параметров модуля”)), и в соответствии с подсоединением к шине
(окно “Properties” (“Свойства”)).
Для более подробной информации, используйте встроенную справку.

3. Переведите CPU в режим STOP (независимо от типа подсоединения -
см. выше).

4. Выберите пункт меню PLC > Download (ПЛК > Загрузка).
STEP 7 проведет Вас через диалоговые окна. Обратите внимание также
на дополнительную информацию в “Руководстве пользователя STEP 7”,
Раздел “Конфигурирование и назначение параметров модулю” /5/.
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Сохранение конфигурационных данных в энергонезависимую память
Во время загрузки Вы можете решить хотите ли Вы загрузить
конфигурационные данные целиком или пошагово. При загрузке пошагово
у Вас будет запрошено начать ли загрузку для каждого модуля отдельно.
Вы можете выбрать этот метод, если Вы хотите сохранить
конфигурационные данные в энергонезависимую память в Ethernet CP.
Для этого подтвердите “Copy to ROM” («Копировать в ROM») в диалоге
"Download" («Загрузка») для CP.

Загрузка сконфигурированных соединений
Чтобы загрузить сконфигурированные соединения, используйте
соответствующую функцию загрузки в конфигурировании соединений
(NETPRO).

Замечание
Если Вы назначили новый адрес для Ethernet CP или сконфигурировали
соединение, Вы всегда должны снова загрузить конфигурацию
соединений.
 Помните, что надо выполнить соответствующие настройки для адресов и
в «замещающих объектах».

Перемещение CP в аппаратной конфигурации
Если Вы используете коммуникационные сервисы с
сконфигурированными соединениями, то ID соединения также связан с
посадочным местом CP. Пожалуйста, имейте в виду следующее
замечание для случая, когда Вы перемещаете уже сконфигурированный
CP в другое посадочное место используя технику "drag and drop"
(«перенести и положить»):

Замечание
Если Вы перемещаете CP в другое посадочное место, конфигурационные
данные соединений автоматически актуализируются. Но вы все равно
должны загрузить их еще раз!
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2.3 Печать конфигурационных данных

Обзор
Если Вы выберите Station > Print (Станция > Печать) из
конфигурирования аппаратуры, Вы можете распечатать следующие
данные:

• Параметр "All" («Все»)
Печать всех конфигурационных данных для выбранной станции S7,
независимо от любого другого выбора.

• Параметр "Overview" («Обзор»)
Печать самых важных конфигурационных данных для выбранной
станции S7, независимо от любого другого выбора.

• Параметр "Selection" («Выбор»)
Печать всех конфигурационных данных для выбранной компоненты.
Это позволяет Вам распечатать только конфигурационные данные для
Ethernet CP, например, выбрав его в аппаратном конфигураторе.

Вы можете получить более подробную информацию из встроенной
справки.
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2.4 Общие замечания о дополнительном пакете NCM
S7 для Industrial Ethernet

Установка
При установке дополнительного пакета NCM S7 для Industrial Ethernet на
Ваш PG/ПК под STEP 7, следуйте рекомендациям из информации о
продукте и файла readme.

Функции
NCM S7 состоит из:

• CP-зависимых диалогов в форме вкладок, которые вызываются из
диалогового поля свойств модулей.

• Диалогов для конфигурирования соединений.

• Диагностических функций, которые Вы можете вызвать из:
- вкладки Diagnostics (Диагностики) диалога свойств
- программной группы SIMATIC в стандартном меню Windows 95/NT

Start

• Функций, доступных в меню Windows 98/NT Start под SIMATIC > STEP7
> NCM:
- Диагностики
- Справки для функций (FC)
- Файл “Readme” с текущей информацией о NCM
- Загрузчика Микропрограмм

Функционирование
Функционирование и использование программного пакета объясняется в
«Руководстве пользователя STEP 7» /5/.
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Значение кнопок
В NCM S7 кнопки снизу вкладок имеют одинаковые функции во всех
вкладках:

OK

Cancel

Все записи во всех вкладках проверяются на
правильность. Диалог закрывается, только
если все записи правильны. Сообщения
отображают несоответствия или ошибки,
которые могут появиться в контексте с
другими записями (например, при
конфигурировании соединений).

Диалог закрывается; ни одно из введенных
во вкладках значений не принимается.
Исключение из этого правила -
дополнительные диалоги во вкладках,
которые были подтверждены OK
(например: свойства сетевого соединения).
При переключении из одной вкладки в
другую, записи не принимаются
автоматически!
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3.1 Обзор

Темы в этом разделе
Это раздел объясняет следующее:

• Как передавать и принимать данные.

• Какие области данных могут быть использованы в CPU S7.

Программирование
Раздел содержит информацию о том, как программировать интерфейс
SEND/RECEIVE в программе пользователя.

Где найти дальнейшую информацию
Дальнейшая информация доступна из следующих источников:

• О программировании и конфигурировании участников соединений
(например, ПЛК SIMATIC S5 с CP 1430 TCP, ПК с CP 1413)
обращайтесь, пожалуйста, к соответствующим руководствам.

• FC для программирования соединений описаны в Разделе 5.2.

• Конфигурирование Ethernet CP с NCM S7 описано в Разделе 4.

Примеры программ
Примеры конфигураций и программ, существующих для интерфейса
SEND/RECEIVE, описаны:

• В примере проекта PROJECT_ETHERNET, который Вы можете
запустить сразу после установки NCM S7; за описанием, обращайтесь
к Примеру /2/.

• В Internet, как загружаемые примеры проектов; обращайтесь к
информации в Приложении C “Поддержка и обучение”.
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3.2 Как работает интерфейс SEND/RECEIVE в CPU

Функциональные блоки (FC)
Для управления передачей данных по соединениям имеются следующие
функциональные блоки (FC):

• AG_SEND/AG_LSEND/AG_FSEND
Это блок берет данные пользователя из заданной области данных
пользователя и передает их в Ethernet CP.

• AG_RECV/AG_LRECV/AG_FRECV
Этот блок заносит принятые данные пользователя в область данных
пользователя, указанную в вызове.

Рисунок ниже иллюстрирует эту ситуацию. Используя FC
AG_SEND/AG_LSEND/AG_FSEND и AG_RECV/AG_LRECV/AG_FRECV
программа пользователя инструктирует Ethernet CP передавать или
принимать данные по сконфигурированному соединению.

Коммуникационные
соединения

Ethernet CPCP

STEP7
Программа
пользователя

Буфер
данных
пользователя

База
данных СР

Ethernet станция SIMATIC S7

прием

передача
Область
данных
пользователя

AG_REC

AG_SEND

Рисунок 3–1 Взаимодействие CPU и Ethernet CP по соединению
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Объем данных
Максимальный объем данных, который может передать Ethernet CP за
одно задание по одному соединению:

Таблица 3–1

Транспортное
ISO

ISO–по–TCP TCP UDP

Передача 8192 байт 8192 байт 8192 байт 2048 байт
Прием 8192 байт 8192 байт 8192 байт 2048 байт

Замечание
Новыми версиями CP поддерживается передача более 240 байт данных.
За более подробной информацией, обращайтесь к информации о
продукте для Вашего Eternet CP.

Обмен данными S7 CPU <-> Ethernet CP
Ethernet CP обрабатывает задания Send и Receive независимо от цикла
CPU, и это занимает определенное время передачи. Интерфейс с
блоками FC в пользовательской программе синхронизируется при помощи
квитирования. Надо различать две ситуации:

• Цикл CPU быстрее времени передачи.

• Цикл CPU медленнее времени передачи.

Замечание
Обращайтесь, пожалуйста, к диаграмам выполнения для FC в Разделе 5.
Эти диаграммы показывают управление интерфейсом SEND/RECEIVE в
программе пользователя для беспроблемного обмена данными.
Имейте в виду приводимую ниже информацию о цикле CPU и времени
передачи.

Вызовы FC быстрее времени передачи
Если в программе пользователя блок вызывается снова, прежде чем
данные были переданы или приняты, то в интерфейсе блоков FC
происходит следующее:

• AG_SEND/AG_LSEND/AG_FSEND:
Дальнейшие задания не принимаются, до тех пор пока передача
данных по соединению не была квитирована станцией Ethernet. В
течение этого времени пользовательская программа получает
сообщение “job active” («активное задание») до тех пор, пока Ethernet
CP не сможет принять следующее задание для этого же соединения.

• AG_RECV/AG_LRECV/AG_FRECV:
Задание квитируется с сообщением “no data available yet” («данных
пока еще нет»), если в Ethernet CP еще нет принятых данные.
Программа пользователя принимает это сообщение в цикле CPU, пока
Ethernet CP не примет снова данные по соединению.



Интерфейс SEND/RECEIVE

SIMATIC NET NCM для Industrial Ethernet 3-5

Вызовы FC медленнее времени передачи
Если блок вызывается снова до того, как были полностью переданы или
приняты данные, то на интерфейсе блоков FC происходит следующее:

• AG_SEND/AG_LSEND AG_FSEND:
Задание квитируется положительно. Ethernet CP готов принять новое
задание на передачу (однако не ранее следующего вызова).

• AG_RECV/AG_LRECV/AG_FRECV:
После того, как данные были отправлены в программу пользователя,
задание квитируется с “New Data Received” (“Получены новые
данные”). После этого может быть повторен вызов FC.

Замечание
Помните, что может возникнуть нехватка ресурсов, если не совпадают
скорости обработки в передатчике и приемнике (передатчик быстрее, чем
приемник).
Если возникают проблемы, то передатчик получает сообщение от FC
(“No resources on the destination station” (“На станции назначения нет
ресурсов”)).
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3.3 Программирование интерфейса SEND/RECEIVE

Принцип передачи задания и данных
Программа пользователя управляет передачей областей данных
пользователя при помощи вызовов блоков FC и наблюдает за
выполнением, обрабатывая биты состояний.

При вызове FC помимо других передаются так же следующие параметры:

•  номер соединения (ID)

•  расположение в CPU
Более подробную информацию об интерфейсе вызовов см. в Разделе 5.

Назначение FC
Вызов функциональных блоков приводит к следующим результатам:

• Область данных пользователя передается в Ethernet CP или
принимается из Ethernet CP.

• Выполнение задания подтверждается положительно или отрицательно
в сообщении о состоянии.

Программирование соединений
Программируйте интерфейс SEND/RECEIVE в программе пользователя
следующим образом:
1. Для передачи данные по соединениям используйте следующие
функциональные блоки (FC):
- AG_SEND для передачи области данных пользователя в Ethernet

CP
- AG_RECV для занесения данных, принятых из Ethernet CP, в
область данных пользователя

2. Обработайте следующие биты в FC:
- для AG_SEND параметры DONE, ERROR, STATUS
- для AG_RECV параметры NDR, ERROR, STATUS

Замечание
Номера соединений (ID) при программировании должны быть взяты из
конфигурации.
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Вызовы FC в программе CPU
На следующем рисунке показана возможная последовательность вызовов
FC вместе с организационными и программными блоками в цикле CPU.

AG_RECV

AG_SEND

AG_SEND

Чтение принятых
данных по соединению

Передача данных по
соединению

Запись PIQ

O

Обозначение: Последовательность цикла CPU

AG_RECV

AG_RECV
Коммуникационное
соединение

AG_SEND

Программа пользователя

Одинаковым фоном показываются
соединяния и связанные с ними блоки FC.

Чтение PII

Коммуникационное
соединение

Коммуникационное
соединение

Рисунок 3–2 Типичная последовательность вызовов функций в цикле CPU
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Вы можете увидеть следующее:

• Программа пользователя, состоящая из любого числа блоков (OB, FB
или FC -> см. также /5/), обращается к нескольким соединениям (на
Рисунке 3–2 показано три соединения).

• Программа пользователя передает данные по соединению из любого
места в программе пользователя (управляемо по событиям и
программно) используя вызовы AG_ SEND.

• Программа пользователя принимает данные из соединения в любом
месте цикла CPU используя вызовы AG_RECV.

Замечание
Блоки для того же коммуникационного соединения могут вызываться
несколько раз за цикл.



SIMATIC NET NCM для Industrial Ethernet 4-1

Конфигурирование
коммуникационных соединений

4.1 Обзор 4–2
4.2 Возможные конфигурации соединений 4–3
4.3 Методика 4–4
4.4 Соединения 4–5
4.4.1 Создание нового соединения 4–8
4.4.2 Изменение партнера соединения 4–13
4.4.3 Свободное соединение UDP 4–15
4.4.4 Другие функции 4–16
4.4.5 Соединения без назначения 4–17
4.5 Конфигурирование транспортного соединения ISO 4–19
4.5.1 Задание партнера транспортного соединения ISO 4–20
4.5.2 Задание транспортных адресов ISO 4–22
4.5.3 Задание динамических свойств транспортного ISO 4–25
4.5.4 Транспортное соединение ISO с режимом FETCH/WRITE 4–27
4.5.5 Проверка свойств транспортных соединений ISO 4–29
4.6 Конфигурирование соединения ISO–по-TCP 4–30
4.6.1 Задание партнера соединения ISO–по-TCP 4–31
4.6.2 Задание адресов ISO–по-TCP 4–33
4.6.3 ISO–по-TCP с режимом FETCH/WRITE 4–36
4.6.4 Проверка свойств соединений ISO–по-TCP 4–38
4.7 Конфигурирование соединения TCP 4–39
4.7.1 Задание партнера соединения TCP 4–40
4.7.2 Задание адресов TCP 4–42
4.7.3 TCP с режимом FETCH/WRITE 4–45
4.7.4 Проверка свойств соединений TCP 4–47
4.8 Конфигурирование соединения UDP 4–48
4.8.1 Задание партнера соединения UDP 4–49
4.8.2 Задание адресов UDP 4–51
4.8.3 Проверка свойств соединений UDP 4–54
4.9 Маршрутизация 4–55

4



Конфигурирование коммуникационных соединений

4-2 SIMATIC NET NCM для Industrial Ethernet

4.1 Обзор

Темы в этом разделе
Это раздел объясняет следующее:

• Общие аспекты конфигурирования коммуникационных соединений

• Как конфигурировать транспортные соединения ISO и соединения ISO–
по–TCP

• Как использовать функции конфигурирования соединений, чтобы
задать партнеров по коммуникации, обменивающихся данными по UDP

Дальнейшая информация
Дальнейшая информация доступна из следующих источников:

• о свойствах конфигурируемых соединений типа
- транспортное ISO
- ISO–по–TCP
- TCP
- UDP (заданные и свободные соединения UDP)
обращайтесь к Разделу 1.5.

• о свойствах конфигурируемых соединение типа E–mail: обращайтесь к
/4/.

• о конфигурировании свойств сети, обращайтесь к Разделу 2.2.2.

• об объеме данных, обращайтесь к Разделу 3.2.

• за информацией о конфигурировании соединений, обращайтесь к
встроенной справке STEP 7 (Help > Contents (Справка > Содержание)).

Примеры программ
Примеры конфигураций и программ, существующих для интерфейса
SEND/RECEIVE, описаны:

• В примере проекта PROJECT_ETHERNET, который Вы можете
запустить сразу после установки NCM S7; за описанием, обращайтесь
к Примеру /2/.

• В Internet, как загружаемые примеры проектов; обращайтесь к
информации в Приложении C “Поддержка и обучение”.
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4.2 Возможные конфигурации соединений

Соединения внутри проекта
Возможные соединения между различными партнерами по связи внутри
проекта показаны на следующем рисунке.
Соединение с партнерами по связи вне проекта, конфигурируются с
использованием замещающих объектов, таких как “Other Stations” (“Другие
станции”) или SIMATIC S5.

Рисунок 4–1 Возможные соединения

S7 - 400 S7 - 300 Ethernet CP
Ethernet CP

Подсеть 1

SIMATIC S5

S7 - 400
Ethernet /IT-CP

Ethernet CP

PG/PC с Ethernet CP

S7 - 400

WAN*
LAN *

Подсеть 2

Ethernet CP

Other station (Другая станция)
с подсоединением к Ethernet

* только TCP/IP

Ethernet CP



Конфигурирование коммуникационных соединений

4-4 SIMATIC NET NCM для Industrial Ethernet

4.3 Методика

Шаги
Для запуска соединений в ПЛК SIMATIC S7 с Ethernet CP необходимы
следующие шаги:

Запрограммируйте в
программе пользователя
интерфейс SEND/RECEIVE.

(Обращайтесь к информации
в Разделе 3.3 и подробному
описанию FC в Разделе 5).

Программирование

Создайте новые
соединения

Если необходимо,
сконфигурируйте для
соединений “Other
Station” (“Другая

станция”) используя
соответствующий
инструментарий.

Загрузите конфигурации
соединений в СР

Сконфигурируйте
свойства соединения

Конфигурирование

Обязательные шаги
Дополнительные шаги

Рисунок 4–2 Использование соединений с Ethernet CP
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4.4 Соединения

Свойства соединения

• Передача данных - двунаправленная, другими словами, по одному
соединению возможна одновременная передача и прием.

• Обе станции обладают одинаковыми правами, другими словами,
каждая станция может запустить процесс передачи и приема в ответ на
события.

• Адрес партнера по связи задается при конфигурировании.
Исключение из этого - свободные соединения UDP. В этом случае,
адрес указывается в программе пользователя в интерфейсе FC.

Коммуникационное
соеднение

Ethernet CP

Узел
Ethernet

Станция SIMATIC S7
с Ethernet CP

прием

передача

Узел
Ethernet

Коммуникационное
соеднение

передача

передача

передача

прием

прием

прием

Рисунок 4–3 Передача и прием по одному коммуникационному соединению

Замечание
Термин “соединение“ здесь используется также и для UDP. Причина: во
время конфигурирования (например, как и для TCP) коммуникационные
партнеры назначаются друг другу и, таким образом, логически
“соединяются“. На самом деле, для UDP не существует явного
установления соединения между партнерами по связи во время работы.
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Объем данных и число соединений
За информацией о количестве соединений, поддерживаемых Ethernet CP,
обращайтесь к информации о продукте /1/, прилагаемом к Ethernet CP.
Число соединений на станцию может быть увеличено добавлением
дополнительных CP.
Максимальный объем данных, который может передать Ethernet CP за
одно задание по одному соединению:

Таблица 4–1

Транспортное ISO ISO-по-TCP UDP
Передача 8192 байт 8192 байт 2048 байт
Прием 8192 байт 8192 байт 2048 байт

Замечание
Новыми версиями CP поддерживается передача более 240 байт данных.
За более подробной информацией, обращайтесь к информации о
продукте для Вашего Eternet CP.

Задачи Ethernet CP
Ethernet CP выполняет следующие задачи по управлению передачей
данных через соединение:

• При приеме
Прием данных из Ethernet и передача их в область данных
пользователя CPU.

• При передаче
Прием данных из области данных пользователя CPU и передача
данных по Ethernet.

Для свободных соединений UDP, в дополнении к выше упомянутым,
необходимы также следующие функции:

• При приеме
Занесение адреса передающего, от которого было получено задание, в
заголовок задания

• При передаче
Анализ заголовка задания и адресация партнера

Соединение устанавливается автоматически, как только партнер
становится доступен.
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Требования для конфигурирования соединений
Ethernet CP был добавлен в аппаратную конфигурацию и подсоединен к
подсети.
Как участник сети, Ethernet CP имеет адрес.

Замечание
Все станции вне проекта S7 должны быть сконфигурированы
замещающими объектами (например, как “SIMATIC S5” или “Other stations”
(«Другие станции»)).
или
При создании соединения используйте “незаданный” тип партнера.
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4.4.1 Создание нового соединения

Принцип
Создание новых соединений Вы начинаете с добавления станций и
подсоединения их к сети. Соединение в текущем проекте S7
конфигурируется начиная со станции или с CPU, и затем выбирая
станцию назначения.
Т.к. станции уже подключены к сети, то адреса узлов двух станций (MAC
или IP адреса) уже известны. Локальным/удаленным TSAP (Transport
Service Access Point - Точка Доступа к Транспортным Службам) или
портам для обоих концов соединения автоматически назначаются
значения по умолчанию.
Если станция партнер – это станция вне текущего проекта или станция
не–S7, то удаленные TSAP или порты должны быть заданы в диалоге
свойств соединения.

Как открыть таблицу соединений
Вы можете открыть таблицу соединений различными способами:
Используя кнопку “Start” («Пуск») в панели задач Windows 98/NT: Simatic
> STEP7 > Configure Networks (Конфигурирование сетей), Вы
открываете графическое представление NETPRO.
В NETPRO следуйте шагам, приведенным ниже:
1. Выберите станцию или CPU в станции, от которой Вы хотите
установить соединение.

2. Выберите пункт меню Insert > New Connection (Вставить > Новое
соединение) (можно также использовать правую кнопку мыши!).

Другой способ: Вы можете начать из SIMATIC Manager, как показано:
1. Выберите Ваш CPU в SIMATIC Manager.
2. Выберите объект Connections (Соединения) ( ).
3. Дважды щелкните по объекту или выберите пункт меню Edit > Open

Object (Правка > Открыть объект).
Результат: на экране появится таблица соединений со всеми
сконфигурированными соединениями для выбранного CPU (локальный
узел).

Конечная точка - CPU
Конечная точка соединения со станцией SIMATIC S7 всегда CPU. Для
каждого CPU создается отдельная таблица соединений, содержащая
партнера соединения и тип соединения.
Из поля “Station” (“Станция”) и «Module» (“Модуль”) Вы можете также
отобразить таблицу соединений для разных узлов.
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Новое соединение
Чтобы сконфигурировать новое соединение, станции и их CP должны
быть сконфигурированы и подсоединены к сети в проекте S7. Чтобы
создать новое соединение, следуйте шагам, приведенным ниже:
1. В строке меню выберите Insert > New Connection (Вставить > Новое
соединение).

 Результат: на экране появится следующий диалог.

Рисунок 4–4 Конфигурация диалога “New Connection” (“Новое соединение”) (Пример для
транспортного соединения ISO)

2. В поле “Station” (“Станция”) выберите станцию, с которой Вы хотите
установить соединение.

3. В поле “Module” (“Модуль”) выберите CPU в этой станции, с которым
Вы хотите установить соединение.

4. В поле “Type” (“Тип”) выберите тип соединения, которое Вы хотите
использовать (например, транспортное соединение ISO).

Когда Вы подтвердите ваш ввод, нажав на “Add” («Добавить»), будет
создано новое соединение, а диалоговое окно "New Connection" («Новое
соединение») останется открытым. Это позволит Вам создать еще
соединения, не открывая окно по несколько раз. Одновременно будет
обновляться список соединений. После того, как Вы создадите все
соединения, Вы можете закрыть диалоговое окно нажав на кнопку “OK”.

Партнер соединения
После того как Вы выберите Вашу локальную станцию, для выбора
отобразятся все удаленные партнеры в проекте S7 и все их
программируемые модули (CPU). Выберите программируемый модуль, с
которым Вы хотите создать соединение.
Если Вы щелкните по OK, соединение будет добавлено в список, диалог
закроется и экран в главном окне обновится.
Если Вы щелкните по Cancel (Отмена), диалог закроется, а соединение
не будет добавлено в список.
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Соединения со станциями не–S7 с использованием замещающих
объектов

Соединения со станциями SIMATIC вне проекта или с другими
устройствами конфигурируются выбирая станции назначения типа
“SIMATIC S5”, «Other Station» (“Другая станция”) или “PG/PC”. Конечная
точка содержит локальный и удаленный адреса.
Т.к. станции уже подключены к сети, то адреса узлов двух станций (MAC
или IP адреса) уже известны. Локальным TSAP (Transport Service Access
Point - Точка Доступа к Транспортным Службам) или портам для обоих
концов соединения автоматически назначаются значения по умолчанию.

Замечание
Соединение со станциями не-S7 (например, SIMATIC S5) создаются как
не полностью заданные соединения; другими словами, отсутствуют
удаленный TSAP или порт. Эти соединения должны быть заданы в
диалоге свойств.
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Незаданные соединения
Соединения с еще неизвестным устройством (например, устройство
диагностики) конфигурируются как “незаданные” соединения. Они могут
быть заданы позже в диалоге свойств.
Вы можете создать незаданное соединение просто выбрав в качестве
партнера по соединению при создании соединения станцию “unspecified”
(“незаданная”). Незаданное соединение может быть использовано двумя
способами (приведенное ниже объяснение основано на примере
соединения ISO–по–TCP (транспортные соединения ISO и соединения
TCP аналогичны)):

• Объявление готовности для связи - установление пассивного
соединения
Установление соединение тогда задано пассивным (см. установки во
вкладке General (Общее)).
Тогда задание адреса для соединения ISO–по–TCP выполняется
следующим образом:
Удаленный IP адрес = 0.0.0.0, а удаленный TSAP - пустой; другими
словами, он не имеет значения для CP. Когда соединение
установлено, то принимается любой партнер (партнер = имя
соединения, который адресует CP с правильным IP адресом и TSAP).
Возможно также частичное задание; другими словами, принимается
связь с партнером, который подходит или по заданному IP адресу или
по заданному TSAP.

• Соединение с заданной станцией в любом проекте
Тогда задание адреса для соединения ISO–по–TCP выполняется
следующим образом:
Вы можете задать удаленный IP адрес и порт любой станции
назначения. Станция назначения может быть в текущем или в другом
проекте STEP 7.
Используйте этот метод, если в текущем проекте Вы не создали
замещающий объект для станции партнера, например, SIMATIC S5.

Следующая таблица показывает различные возможности.

Таблица 4–2

Значения для установления
соединения

IP Адрес / MAC
Адрес

TSAP / Порт Возможные
установления
соединения

с любым партнером Пусто Пусто Пассивное
с заданным партнером
с любым TSAP

Задано Пусто Пассивное

с любым партнером
с заданным TSAP

Пусто Задано Пассивное

к или от заданного партнера Задано Задано Активное / пассивное
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Свободное соединение UDP это другой вариант. С этим типом
соединения адрес партнера соединения остается открытым во время
конфигурации. Участники связи идентифицируются в программе
пользователя по информации об адресе в коммуникационном задании.
Это означает, что по сконфигурированному свободному (незаданному)
соединению UDP может быть адресовано до 126 узлов, если эти узлы
поддерживают соединение UDP.
Для дальнейшей информации обращайтесь к разделам, посвященным
заданным соединениям.

Замечание
За информацией о количестве соединений, поддерживаемых Ethernet CP,
обращайтесь к информации о продукте /1/, прилагаемом к Ethernet CP.
Если в одной станции установлено несколько CP, то следующий CP
выбирается автоматически, если превышен предел. Вы можете
переназначить соединения в диалоге свойств.
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4.4.2 Изменение партнера соединения

Введение
Помимо создания нового соединения, Вы также можете изменить
партнера по соединению для любого уже сконфигурированного
соединения.

Вызов диалога
Чтобы вызвать диалог “Change Connection Partner” (“Изменение партнера
по соединению”), следуйте шагам показанным ниже:
1. Выберите требуемое соединение в таблице соединений.
2. Выберите пункт меню Edit > Connection Partner… (Правка > Партнер
соединения...)

Результат:

Рисунок 4–5 Конфигурация диалога “Change Connection Partner” (“Изменение партнера по
соединению”) (Пример для транспортного соединения ISO)

Партнер соединения
Также как и при создании нового соединения для выбора отображаются
все станции из проекта S7. Выберите программируемый модуль, с
которым Вы хотите создать соединение.
Если Вы щелкните по OK, соединение будет добавлено в список, диалог
закроется и экран в главном окне обновится.
Если Вы щелкните по Cancel (Отмена), диалог закроется, а соединение
не будет добавлено в список.
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Диалоги свойств
Диалоги свойств для различных типов соединения объясняются в
следующих разделах:

• Транспортные соединения ISO - см. Раздел 4.5

• Соединения ISO–по–TCP - см. Раздел 4.6

• Соединения TCP - см. Раздел 4.7

• UDP - см. Раздел 4.8
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4.4.3 Свободное соединение UDP

Программноуправляемая адресация
Свободное соединение UDP позволяет программноуправляемую
адресацию партнера по связи. Коммуникация между двумя узлами по
Industrial Ethernet имеет следующие свойства:

• Передача данных - двунаправленная, другими словами, по одному
соединению UDP возможна одновременная передача и прием.

• Локальный узел задается при конфигурировании. Удаленный узел
вводится программой пользователя в заголовок задания из буфера
задания, при вызовах AG_SEND. Это позволяет адресовать любой
узел на Ethernet/LAN/WAN.

• IP адрес и порт передающего может быть прочитан из заголовка
задания AG_RECV.

Незаданное
соединение UDP

Узел Ethernet
(незаданный)

Станция SIMATIC S7
с Ethernet CP

прием

передача прием

передача
Auftragsheade

Заголовок
задания

Данные
пользователя

Область данных
пользователя

Буфер задания

Рисунок 4–6 Передача и прием по незаданным соединениям UDP с программной адресацией

Объем данных и число соединений
За информацией о количестве соединений, поддерживаемых Ethernet CP,
обращайтесь к информации о продукте /1/, прилагаемом к Ethernet CP.
Число соединений на станцию может быть увеличено добавлением
дополнительных на буфер CP.
На один буфер задания может быть передано до 2042 байт данных
пользователя. Заголовок задания занимает дополнительно 6 байт.
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4.4.4 Другие функции

Панель инструментов
Панель инструментов диалога конфигурирования соединений предлагает
следующие функции:

Сохранить Чтобы сохранить сконфигурированные соединения, выберите функцию
Save (Сохранить) или щелкните по пиктограмме сохранения.

Печать Вы можете распечатать всю таблицу соединений или выбранную часть
ее. Выберите для этого функцию Print (Печать), или щелкните по
пиктограмме печати.
Доступны следующие варианты печати:
• Обзор всех соединений (вся таблица соединений)
• Обзор выбранных соединений (выбранная область)
• Подробная печать всех соединений (подробности всех соединений)
• Подробная печать выбранных соединений (подробности выбранной

области)
Изменить партнера
по соединению

Вы можете назначить новую станцию партнера для выбранного
соединения.
Важно!
Помните, что это также меняет ID партнера для соединения интерфейса
SEND/RECEIVE. Возможно Вам придется адаптировать Вашу программу
пользователя.

Вставить соединение Вы создаете новую запись в таблице соединений.

Загрузка Вы загружаете таблицу соединений в ПЛК. Для более подробной
информация обращайтесь к встроенной справке.

Помощь Если Вам требуется справка или дополнительная информация, выберите
функцию Help (Справка) или щелкните по пиктограмме справки.
Пиктограмма справки предложит Вам контекстно-зависимую
информацию, а функция справки выведет окно справки, известное Вам по
стандартным приложениям Windows.
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4.4.5 Соединения без назначения

Обзор
Это раздел описывает действия, которые могут привести к тому, что
сконфигурированные соединения потеряют назначение к CP или
удалятся.

Замечание
Помните, что в отличии от соединений S7, соединениям интерфейса
SEND/RECEIVE назначаются ID, зависящие от CP. Действия,
приведенные ниже, могут потребовать изменения ID, что потребует за
собой адаптации в программе пользователя параметров интерфейса.

Таблица 4–3 Действия, которые могут вызвать изменения в сконфигурированных соединениях

Действие Влияние на соединения Как восстановить соединение
CP (модуль) перемещен
в другое место в
аппаратной
конфигурации
(Drag&Drop)

Соединения остаются.
ID соединений обновляются
автоматически.

1. Адаптируйте начальный адрес
модуля LADDR в программе
пользователя.

2. Загрузите снова конфигурацию
соединений в CP.

CP (модуль) удален в
аппаратной
конфигурация.
Появится сообщение “CP
has n connections; the
assignment will be lost in
the connection table” (“CP
имеет n соединений;
назначения в таблице
соединений будут
потеряны”).

В таблице соединений
соединения остаются без
назначений к CP. Во вкладке
“Overview” (“Обзор”) диалога
свойств соединение
помечается “!”.

Когда Вы добавили CP в аппаратную
конфигурацию и подключили его к
сети:
1. Назначьте CP к соединению

используя вкладку "Addresses"
(«Адреса») в диалоге свойств
соединения.
или
Переназначте соединение
используя пункт меню Edit >
Connection Partner (Правка >
Партнер соединения).

2. Адаптируйте ID соединения в
программе пользователя.

3. Загрузите снова конфигурацию
соединений в CP.

Удаление станции
SIMATIC S7.

Все соединения с этой
станцией в проекте удаляются.

Переконфигурируйте станцию и
соединения.

Удаление станции
партнера.

В таблице соединений
остаются соединения от
станций в проекте к удаленным
станциям, но без назначения.
Во вкладке “Overview” (“Обзор”)
диалога свойств соединение
помечается “!”.

Переназначте станцию партнера (или
даже локальную станцию) используя
пункт меню Edit > Connection Partner
(Правка > Партнер соединения).

Изменение назначения
подсети для CP.

В таблице соединений
остаются соединения, которые
были назначены через это CP,
но без назначения. Во вкладке
“Overview” (“Обзор”) диалога
свойств соединение
помечается “!”.

Переназначте соединение, используя
пункт меню Edit > Connection Partner
(Правка > Партнер соединения) или
вкладку “Addresses” (“Адреса”)
диалога свойств соединения.
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Экран (Пример)
Состояние соединения отображается в диалоге “Properties ISO Transport
Connection” (“Свойства - Транспортное соединение ISO”).

Help Help
Cancel Cancel

Рисунок 4–7 Состояние cоединений во вкладке “Overview” (“Обзор”) (Пример для транспортных
соединений ISO)

Замечание
Если CP заменяется другим CP, он должен обеспечивать по крайней мере
те же сервисы и должен быть как минимум той же версии.
Если Вы заменяете CPU, то все соединения теряются.
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4.5 Конфигурирование транспортного соединения ISO

Введение
Помимо добавления в таблицу соединений, Вы также можете изменить
специальные свойства каждого сконфигурированного соединения.
Здесь Вы можете изменить отдельные параметры соединения, которые
были заданы по умолчанию в диалоге "Новое соединение".

Вызов диалога
Чтобы вызвать диалог специальных свойств соединения, следуйте шагам,
показанным ниже:
1. Выберите требуемое соединение в таблице соединений.
2. Выберите пункт меню Edit > Object Properties (Правка > Свойства
объекта)

Результат: появится диалог “Properties ISO Transport Connection”
(“Свойства - Транспортное соединение ISO”).

Вкладки
Для транспортного соединения ISO доступны следующие вкладки:

• General (Общее)
Отображает общие параметры соединения и локальное имя
транспортного соединения ISO.

• Addresses (Адреса)
Отображает информацию о локальном и удаленном адресах.

• Dynamics (Динамика)
Отображает соответствующие таймеры и счетчики.

• Options (Параметры)
Здесь, Вы можете выбрать режимы:

- FETCH или WRITE

- Fast SEND/RECV

• Overview (Обзор)
Обзор всех сконфигурированных транспортных соединений ISO вместе
с их параметрами для выбранной станции S7 и состоянием
соединения.
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4.5.1 Задание партнера транспортного соединения ISO

Вкладка General (Общее)
Эта вкладка в диалоге свойств отображает параметры соединения и
локальное имя соединения транспортного соединения ISO.

Локальный ID идентичен ID в таблице соединений NetPro (STEP 7
конфигурация соединения) и отображается здесь для информации о
присваивании.

Рисунок 4–8 Конфигурация вкладки “General” (“Общее”) диалога свойств транспортного
соединения ISO
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Атрибуты Описание Доступ
Connection
Endpoint
(Конечные точки
соединения)
Local ID
(Локальный ID)

Идентичен значению в списке соединений Выбираемо

Name
(Имя)

Предлагаемое имя, которое может быть изменено
пользователем. Для незаданных соединений используйте это
поле для идентификации партнера.

Изменяемо

Via CP
(Через CP)

Если станция содержит несколько CP одного типа,
подсоединенных к одной подсети, Вы можете выбрать маршрут
соединения -> “Route” («Маршрут»), см. Раздел 4.9.
Если нет назначенного CP (например, если CP был ранее
удален), здесь отобразиться “none” («нет»).

Только для
чтения

Active Connection
Establishment
(Установление
активного
соединения)

По-умолчанию, устанавливаемое соединение активно. Если
соединение незаданное, оно устанавливается пассивным.
ON: соединение установлено активным.
OFF: соединение устанавливается партнером.

Изменяемо

Block Parameters
(Параметры
блока)
ID Это значение должно быть введено в программе пользователя

как параметр ID вызова блока FC для идентификации
соединения. ID изменяется, если изменяется локальный ID.

Только для
чтения

LADDR Это значение должно быть введено в программе пользователя
как параметр ID вызова блока FC для идентификации
соединения.

Только для
чтения

Параметр “Active Connection Establishment“ (“Установление активного
соединения“)

Этим параметром Вы задаете, будет ли соединение установлено этой
станцией S7. Если адрес партнера задан, то этот параметр выбран по
умолчанию.
Если при создании соединения Вы выбрали “незаданного” партнера, то по
умолчанию параметр не выбран. Если Вы активируете этот параметр, Вы
также должны будете задать адрес партнера во вкладке “Addresses”
(«Адреса»).
Если во вкладке "Option" ("Параметры") Вы выберите FETCH или WRITE,
то этот параметр не будет выбран (установление пассивного соединения)
и не может быть активирован.
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4.5.2 Задание транспортных адресов ISO

Адресные параметры
Транспортное соединение ISO задается указанием локальных и
удаленных конечных точек соединения.

• Локальные адреса:
Локальный MAC адрес и локальный TSAP
(Transport Service Access Point - Точка Доступа к Транспортным
Службам)

• Удаленные адреса:
Удаленный MAC адрес и удаленный TSAP

Транспортное
соединение ISO

MAC
адрес A

Ethernet станция BEthernet станция A

MAC
адрес B

Удаленный
TSAP

TSAP

Локадьный
TSAP

Удаленный
TSAPЛокадьный

Рисунок 4–9 Передача и прием по одному транспортному соединению ISO

Замечание
При конфигурировании Ethernet CP и станции назначения Ethernet, TSAP
транспортных соединений ISO должны соответствовать друг другу:
Удаленный TSAP (в Ethernet CP) = локальному TSAP (в станции
назначения)
Локальный TSAP (в Ethernet CP) = удаленному TSAP (в станции
назначения)
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Вкладка Addresses (Адреса)
Вкладка Addresses (Адреса) отображает предлагаемые значения для
соответствующих локальных и удаленных адресов. В случае соединения
со станциями не-S7, Вы можете задать адреса TSAP индивидуально.

Рисунок 4–10 Конфигурация вкладки “Addresses” («Адреса») диалога свойств со значениями
TSAP по умолчанию

Формат TSAP
Транспортные соединения ISO имеют TSAP длиной от 1 до 32 байт. При
вводе значения текущая длина отображается автоматически (на экране
отображается: 20 символов ASCII). Локальный и удаленный TSAP могут
быть введены как шестнадцатиричные значения или как строки ASCII. При
вводе ASCII, вводимые символы будут также отображаться в
шестнадцатиричном формате. При вводе в шестнадцатиричном виде,
печатные символы отобразятся в ASCII (на экране отображается 8
шестнадцатиричных символов). Если Вы введете непечатные символы, то
поле ASCII станет серым (дальнейший ввод ASCII не возможен), а
непечатные символы отобразятся точками.

Локальный и удаленный TSAP
Удаленный и локальные TSAP могут быть одинаковыми, т.к. соединение
однозначно определяется различными MAC адресами. Если между двумя
станциями используется более, чем одно соединение, то TSAP также
должны быть разными.
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Значение TSAP по умолчанию
При конфигурировании локального и удаленного TSAP, Вам будет
предложено значение по умолчанию, например, для первого соединения
между двумя партнерами “ISO–1” (может быть изменено). Для нового
соединения между этими же двумя партнерами будет предложено
значение по умолчанию “ISO–2”. Для нового соединения с новым
партнером будет опять использовано значение ISO–1.

Вкладка Addresses (Адреса) - Незаданное транспортное соединение ISO
Если Вы выберите тип партнера - “незаданный”, то здесь, в зависимости
от Ваших целей, Вы можете ввести адрес партнера по связи. Имеющиеся
параметры подробно объясняются в Разделе 4.4.1.
Вкладка Addresses (Адреса), показанная здесь, отображает ситуацию, в
которой не заданы удаленный MAC адрес и удаленный TSAP. Если Вы не
выполните дальнейших вводов, то Вы разрешаете установление
соединения с любым партнером по связи.

Рисунок 4–11Конфигурация вкладки “Addresses” (“Адреса”) диалога свойств для незаданных
соединений
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4.5.3 Задание динамических свойств транспортного ISO

Вкладка Dynamics (Динамика)
Вкладка Dynamics (Динамика) отображает соответствующие таймеры и
счетчики для этого соединения. Обычно Вы можете принять эти значения
по умолчанию.
Если необходимо (например, при соединении с системами не–Simatic), Вы
можете установить таймеры и счетчики индивидуально и влиять на
динамическое поведение соединения.

Рисунок 4–12 Конфигурация вкладки “Dynamics” (“Динамика”) диалога свойств
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Атрибуты Описание Доступ
Connection Establishment
(Установление соединения)

Retransmission Time
(Время повторной
передачи)

Время повторной передачи определяет интервал
времени, после которого может быть еще раз
запущена попытка установления неуспешного
соединения (1-60 сек., значение по умолчанию 5
сек.)
- если установление соединения активно
- если установление соединения пассивно (-> не
имеет значение)

Изменяемо
Только для
чтения

Data Transfer
(Передача данных)

Retransmission time
(Время повторной
передачи)

Это параметр определяет интервал времени, после
которого может быть еще раз запущена попытка
неудачной передачи (100-30000 милисек., значение
по умолчанию 1000 милисек.).

Изменяемо

Max. Count
(Макс. счетчик)

Максимальный счетчик - число попыток передачи,
включаю первую (1-100, значение по умолчанию 5).

Изменяемо

Inactivity Time
(Время отключения)

Время отключения определяет интервал времени,
после которого соединение разрывается, если от
партнера не получено «признаков жизни» (6-180
сек., значение по умолчанию 30 сек.).

Изменяемо

Window Time
(Время окна)

Время окна определяет интервал времени, с
которым передаются сигналы о «признаках жизни».
Для SIMATIC NET CP время окна установлено
равным 1/3 времени отключения (2-60 сек.,
значение по умолчанию 10 сек.). Кадры о
«признаках жизни» передаются для проверки
соединения, когда нет передачи данных.

Только для
чтения

Замечание
Время окна и Время отключения
На кадр о «признаке жизни» партнер отвечает своим кадром. Они
передаются партнером по прошествии времени окна. Чтобы избежать
ненужного разрыва соединения, время отключения должно быть как
минимум в три раза больше времени окна.
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4.5.4  Транспортное соединение ISO с режимом FETCH/WRITE

Использование FETCH PASSIVE / WRITE PASSIVE
Если Вы выберите один из следующих двух режимов для транспортных
соединений ISO, Вы можете получить прямой доступ к системной области
ПЛК SIMATIC S7 из станции SIMATIC S5 или другой станции не–S7.

Рисунок 4–13

При этом соединение может быть использовано только для этого режима;
передача или прием с FC AG_SEND/AG_LSEND/AG_FSEND или
AG_RECV/AG_LRECV/AG_FRECV больше не возможна.
Установление соединения пассивно; другими словами, только станция
партнер (станция SIMATIC S5 или другая станция не–S7) может
установить соединение. Соответствующие установки во вкладке “General”
(“Общее”) выполняются автоматически и не могут быть изменены.

• FETCH
Выбрав режим FETCH, Вы разрешаете прямой доступ для чтения
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.

• WRITE
Выбрав режим WRITE, Вы разрешаете прямой доступ для записи
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.
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Замечание
Помните, что если Вы используйте эту конфигурацию с S7–300, то в CPU
S7–300 используется один ресурс соединения (свободное соединение для
функций S7)! Ресурсы соединения CPU также занимаются, например, при
использовании FMS CP S7-300 или устройством программирования или
OP. Для более подробной информации о максимальном количестве
ресурсов соединения, обращайтесь к /12/ и /6/.

Системная память
Используя FETCH или WRITE Вы можете иметь доступ к следующим
адресным областям системной памяти ПЛК SIMATIC S7:

• Блоки данных (DB)
(При доступе к DB, помните что максимальный номер DB = 255.)

• Битовая память (M, MB, MW, MD)

• Область отображения входов (I, IB, IW, ID)

• Область отображения выходов (Q, QB, QW, QD)

• Область периферии входов (PIB, PIW, PID)

• Область периферии выходов (PQB, PQW, PQD)

• Счетчики (C)

• Таймеры (T)

Подключение к другим системам
Режимы FETCH и WRITE, поддерживаемые по транспортному
соединению ISO и соединению ISO–по–TCP, могут быть также
использованы любым другим устройством другого производителя для
доступа к системной области памяти S7.
Чтобы использовать эти типы доступа (например, для приложений ПК),
Вы должны знать структуру заданий PDU. Требуемые заголовки S7 или S5
для кадров запроса и ответа имеют длину 16 байт, а их структура описана
в Приложение C.
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4.5.5 Проверка свойств транспортных соединений ISO

Вкладка Overview (Обзор)
Вкладка Overview (Обзор) отображает все ранее сконфигурированные
транспортные соединения ISO для этой станции и их параметры (только
для информации). Вы можете установить ширину колонок во вкладке
“Overview” (“Обзор”) индивидуально.

Рисунок 4–14 Конфигурация вкладки “Overview” (“Обзор”) диалога свойств

Параметр Описание
Local ID
(Локальный ID)

Это ID транспортных соединений ISO

Conn. Name
(Имя соединения)

Введенное имя соединения идентифицирует транспортное соединение
ISO.

R/S Носитель модулей/слот локального CP, через который установлено
соединение.

Remote Address
(Удаленный адрес)

Задает удаленный MAC адрес соединения в подсети Ethernet.

Local TSAP
(Локальныq TSAP)

Локальная точка доступа к транспортному сервису.

Remote TSAP
(Удаленный TSAP)

Удаленная точка доступа к транспортному сервису.

Status
(Состояние)

Состояние отображает текущее состояние конфигурации соединения.
“Соединение без назначение” в колонке состояния отображается как
“No local CP/No remote CP” (“Нет локального CP/Нет удаленного CP”) и
символом “!” в конце “Local ID” (“Локальный ID”) (например: 0002 A000!).
Соединение в состоянии редактирования также помечаются “!” в конце
“Local ID” (“Локальный ID”).

Если в станции S7 Вы используете несколько CPU, Вы можете щелкнуть
по флажку, чтобы увидеть обзор соединений для всех CPU.
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4.6 Конфигурирование соединения ISO–по-TCP

Введение
Помимо добавления в таблицу соединений, Вы также можете изменить
специальные свойства каждого сконфигурированного соединения.
Здесь Вы можете изменить отдельные параметры соединения, которые
были заданы по умолчанию в диалоге "Новое соединение".

Вызов диалога
Чтобы вызвать диалог специальных свойств соединения, следуйте шагам,
показанным ниже:
1. Выберите требуемое соединение в таблице соединений.
2. Выберите пункт меню Edit > Object Properties (Правка > Свойства
объекта)

Результат: появится диалог “Properties ISO–on-TCP Connection”
(“Свойства - Соединение ISO–по-TCP”).

Вкладки
Для соединения ISO–по-TCP доступны следующие вкладки:

• General (Общее)
Отображает общие параметры соединения и локальное имя
соединения ISO–по-TCP.

• Addresses (Адреса)
Отображает информацию о локальном и удаленном адресах.

• Dynamics (Динамика)
Отображает соответствующие таймеры и счетчики.

• Options (Параметры)
Здесь, Вы можете выбрать режимы

- FETCH или WRITE
– Fast SEND/RECV

• Overview (Обзор)
Обзор всех сконфигурированных соединений ISO–по-TCP вместе с их
параметрами для выбранной станции S7 и состоянием соединения.
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4.6.1 Задание партнера соединения ISO–по-TCP

Вкладка General (Общее)
Эта вкладка в диалоге свойств отображает параметры соединения и
локальное имя соединения ISO–по-TCP.

Локальный ID идентичен ID в таблице соединений NetPro (STEP 7
конфигурация соединения) и отображается здесь для информации о
присваивании.

Рисунок 4–15 Конфигурация вкладки “General” (“Общее”) диалога свойств соединения ISO–по-
TCP
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Атрибуты Описание Доступ
Connection
Конечная точка
(Конечные точки
соединения)
Local ID
(Локальные ID)

Идентичен значению в списке соединений Выбираемо

Name
(Имя)

Предлагаемое имя, которое может быть изменено
пользователем. Для незаданных соединений используйте это
поле для идентификации партнера.

Изменяемо

Via CP
(Через CP)

Если станция содержит несколько CP одного типа,
подсоединенных к одной подсети, Вы можете выбрать маршрут
соединения -> “Route” («Маршрут»), см. Раздел 4.9.
Если нет назначенного CP (например, если CP был ранее
удален), здесь отобразиться “none” («нет»).

Только для
чтения

Active Connection
Establishment
(Установление
активного
соединения)

По-умолчанию, устанавливаемое соединение активно. Если
соединение незаданное, оно устанавливается пассивным.
ON: соединение установлено активным.
OFF: соединение устанавливается партнером.

Изменяемо

Block Parameters
(Параметры
блока)
ID Это значение должно быть введено в программе пользователя

как параметр ID вызова блока FC для идентификации
соединения. ID изменяется, если изменяется локальный ID.

Только для
чтения

LADDR Это значение должно быть введено в программе пользователя
как параметр ID вызова блока FC для идентификации
соединения.

Только для
чтения

Параметр “Active Connection Establishment“ (“Установление активного
соединения“)

Этим параметром Вы задаете, будет ли соединение установлено этой
станцией S7. Если адрес партнера задан, то этот параметр выбран по
умолчанию.
Если при создании соединения Вы выбрали “незаданного” партнера, то по
умолчанию параметр не выбран. Если Вы активируете этот параметр, Вы
также должны будете задать адрес партнера во вкладке “Addresses”
(«Адреса»).
Если во вкладке "Option" ("Параметры") Вы выберите FETCH или WRITE,
то этот параметр не будет выбран (установление пассивного соединения)
и не может быть активирован.
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4.6.2 Задание адресов ISO–по-TCP

Адресные параметры
Соединение ISO–по-TCP задается указанием локальных и удаленных
конечных точек соединения.

• Локальные адреса:
Локальный IP адрес и локальный TSAP
(Transport Service Access Point - Точка Доступа к Транспортным
Службам)

• Удаленные адреса:
Удаленный IP адрес и удаленный TSAP

Транспортное
соединение
ISO-по-TCP

IP
адрес A

Ethernet станция BEthernet станция A

IP
адрес B

Удаленный
TSAP

TSAP

Локадьный
TSAP

Удаленный
TSAPЛокадьный

Рисунок 4–16 Передача и прием по одному соединению ISO–по-TCP

Параметры адресов конфигурируются с NCM S7 и хранятся в базе данных
СР. Поэтому изменение и расширение топологии сети Ethernet не влияет
на программу пользователя в CPU.

Замечание
При конфигурировании Ethernet CP и станции назначения Ethernet, TSAP
соединений ISO–по-TCP должны соответствовать друг другу:
Удаленный TSAP (в Ethernet CP) = локальному TSAP (в станции
назначения)
Локальный TSAP (в Ethernet CP) = удаленному TSAP (в станции
назначения)
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Вкладка Addresses (Адреса)
Вкладка Addresses (Адреса) отображает предлагаемые значения для
соответствующих локальных и удаленных адресов. В случае соединения
со станциями не-S7, Вы можете задать адреса TSAP индивидуально.

Рисунок 4–17 Конфигурация вкладки “Addresses” («Адреса») диалога свойств со значениями
TSAP по умолчанию

Формат TSAP
Соединения ISO–по-TCP имеют TSAP длиной от 1 до 32 байт. При вводе
значения текущая длина отображается автоматически (на экране
отображается: 20 символов ASCII). Локальный и удаленный TSAP могут
быть введены как шестнадцатиричные значения или как строки ASCII. При
вводе ASCII, вводимые символы будут также отображаться в
шестнадцатиричном формате. При вводе в шестнадцатиричном виде,
печатные символы отобразятся в ASCII (на экране отображается 8
шестнадцатиричных символов). Если Вы введете непечатные символы, то
поле ASCII станет серым (дальнейший ввод ASCII не возможен), а
непечатные символы отобразятся точками.

Локальный и удаленный TSAP
Удаленный и локальные TSAP могут быть одинаковыми, т.к. соединение
однозначно определяется различными MAC адресами. Если между двумя
станциями используется более, чем одно соединение, то TSAP также
должны быть разными.
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Значение TSAP по умолчанию
При конфигурировании локального и удаленного TSAP, Вам будет
предложено значение по умолчанию, например, для первого соединения
между двумя партнерами “TCP–1” (может быть изменено). Для нового
соединения между этими же двумя партнерами будет предложено
значение по умолчанию “TCP–2”. Для нового соединения с новым
партнером будет опять использовано значение TCP–1.

Вкладка Addresses (Адреса) - Незаданное соединение ISO–по-TCP
Если Вы выберите тип партнера - “незаданный”, то здесь, в зависимости
от Ваших целей, Вы можете ввести адрес партнера по связи. Имеющиеся
параметры подробно объясняются в Разделе 4.4.1.
Вкладка Addresses (Адреса), показанная здесь, отображает ситуацию, в
которой не заданы удаленный MAC адрес и удаленный TSAP. Если Вы не
выполните дальнейших вводов, то Вы разрешаете установление
соединения с любым партнером по связи.

Рисунок 4–18 Конфигурация вкладки “Addresses” (“Адреса”) диалога свойств для незаданных
соединений
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4.6.3 ISO–по-TCP с режимом FETCH/WRITE

Использование FETCH PASSIVE / WRITE PASSIVE
Если Вы выберите один из следующих двух режимов для соединений
ISO–по-TCP, Вы можете получить прямой доступ к системной области
ПЛК SIMATIC S7 из станции SIMATIC S5 или другой станции не–S7.

Рисунок 4–19

При этом соединение может быть использовано только для этого режима;
передача или прием с FC AG_SEND/AG_LSEND/AG_FSEND или
AG_RECV/AG_LRECV/AG_FRECV больше не возможна.
Установление соединения пассивно; другими словами, только станция
партнер (станция SIMATIC S5 или другая станция не–S7) может
установить соединение. Соответствующие установки во вкладке “General”
(“Общее”) выполняются автоматически и не могут быть изменены.

• FETCH
Выбрав режим FETCH, Вы разрешаете прямой доступ для чтения
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.

• WRITE
Выбрав режим WRITE, Вы разрешаете прямой доступ для записи
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.
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Замечание
Помните, что если Вы используйте эту конфигурацию с S7–300, то в CPU
S7–300 используется один ресурс соединения (свободное соединение для
функций S7)! Ресурсы соединения CPU также занимаются, например, при
использовании FMS CP S7-300 или устройством программирования или
OP. Для более подробной информации о максимальном количестве
ресурсов соединения, обращайтесь к /12/ и /6/.

Системная память
Используя FETCH или WRITE Вы можете иметь доступ к следующим
адресным областям системной памяти ПЛК SIMATIC S7:

• Блоки данных (DB)
(При доступе к DB, помните что максимальный номер DB = 255.)

• Битовая память (M, MB, MW, MD)

• Область отображения входов (I, IB, IW, ID)

• Область отображения выходов (Q, QB, QW, QD)

• Область периферии входов (PIB, PIW, PID)

• Область периферии выходов (PQB, PQW, PQD)

• Счетчики (C)

• Таймеры (T)

Подключение к другим системам
Режимы FETCH и WRITE, поддерживаемые по транспортному
соединению ISO и соединению ISO–на–TCP, могут быть также
использованы любым другим устройством другого производителя для
доступа к системной области памяти S7.
Чтобы использовать эти типы доступа (например, для приложений ПК) Вы
должны знать структуру заданий PDU. Требуемые заголовки S7 или S5
для кадров запроса и ответа имеют длину 16 байт, а их структура описана
в Приложение C.
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4.6.4 Проверка свойств соединений ISO–по-TCP

Вкладка Overview (Обзор)
 Вкладка Overview (Обзор) отображает все ранее сконфигурированные
соединения ISO–по-TCP для этой станции и их параметры (только для
информации). Вы можете установить ширину колонок во вкладке
“Overview” (“Обзор”) индивидуально.

Рисунок 4–20 Конфигурация вкладки “Overview” (“Обзор”) диалога свойств

Параметр Описание
Local ID
(Локальный ID)

Это ID соединений ISO–по-TCP

Conn. Name
(Имя соединения)

Введенное имя соединения идентифицирует соединение ISO–по-TCP.

R/S Носитель модулей/слот локального CP, через который установлено
соединение.

Remote Address
(Удаленный адрес)

Задает удаленный MAC адрес соединения в подсети Ethernet.

Local TSAP
(Локальные TSAP)

Локальная точка доступа к транспортному сервису.

Remote TSAP
(Удаленный TSAP)

Удаленная точка доступа к транспортному сервису.

Status
(Состояние)

Состояние отображает текущее состояние конфигурации соединения.
“Соединение без назначение” в колонке состояния отображается как
“No local CP/No remote CP” (“Нет локального CP/Нет удаленного CP”) и
символом “!” в конце “Local ID” (“Локальный ID”) (например: 0002 A000!).
Соединение в состоянии редактирования также помечаются “!” в конце
“Local ID” (“Локальный ID”).

Если в станции S7 Вы используете несколько CPU, Вы можете щелкнуть
по флажку, чтобы увидеть обзор соединений для всех CPU.
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4.7 Конфигурирование соединения TCP

Введение
Помимо добавления в таблицу соединений, Вы также можете изменить
специальные свойства каждого сконфигурированного соединения.
Здесь Вы можете изменить отдельные параметры соединения, которые
были заданы по умолчанию в диалоге новое соединение.

Вызов диалога
Чтобы вызвать диалог специальных свойств соединения, следуйте шагам,
показанным ниже:
1. Выберите требуемое соединение в таблице соединений.
2. Выберите пункт меню Edit > Object Properties (Правка > Свойства
объекта)

Результат: появится диалог “Properties TCP Connection” (“Свойства -
Соединение TCP”).

Вкладки
Для соединения TCP доступны следующие вкладки:

• General (Общее)
Отображает общие параметры соединения и локальное имя
соединения TCP.

• Addresses (Адреса)
Отображает информацию о локальном и удаленном адресах.

• Options (Параметры)
Здесь, Вы можете выбрать режимы FETCH или WRITE.

• Overview (Обзор)
Обзор всех сконфигурированных соединений TCP вместе с их
параметрами для выбранной станции S7 и состоянием соединения.



Конфигурирование коммуникационных соединений

4-40 SIMATIC NET NCM для Industrial Ethernet

4.7.1 Задание партнера соединения TCP

Вкладка General (Общее)
Эта вкладка в диалоге свойств отображает параметры соединения и
локальное имя соединения TCP.
Локальный ID идентичен ID в таблице соединений NetPro (STEP 7
конфигурация соединения) и отображается здесь для информации о
присваивании.

Рисунок 4–21Конфигурация вкладки “General” (“Общее”) диалога свойств соединения TCP
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Атрибуты Описание Доступ
Connection
Конечная точка
(Конечные точки
соединения)
Local ID
(Локальные ID)

Идентичен значению в списке соединений Выбираемо

Name
(Имя)

Предлагаемое имя, которое может быть изменено
пользователем. Для незаданных соединений используйте это
поле для идентификации партнера.

Изменяемо

Via CP
(Через CP)

Если станция содержит несколько CP одного типа,
подсоединенных к одной подсети, Вы можете выбрать маршрут
соединения -> “Route” («Маршрут»), см. Раздел 4.9.
Если нет назначенного CP (например, если CP был ранее
удален), здесь отобразиться “none” («нет»).

Только для
чтения

Block Parameters
(Параметры
блока)
ID Это значение должно быть введено в программе пользователя

как параметр ID вызова блока FC для идентификации
соединения. ID изменяется, если изменяется локальный ID.

Только для
чтения

LADDR Это значение должно быть введено в программе пользователя
как параметр ID вызова блока FC для идентификации
соединения.

Только для
чтения

Параметр “Active Connection Establishment“ (“Установление активного
соединения“)

Этим параметром Вы задаете, будет ли соединение установлено этой
станцией S7. Если адрес партнера задан, то этот параметр выбран по
умолчанию.
Если при создании соединения Вы выбрали “незаданного” партнера, то по
умолчанию параметр не выбран. Если Вы активируете этот параметр, Вы
также должны будете задать адрес партнера во вкладке “Addresses”
(«Адреса»).
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4.7.2 Задание адресов TCP

Адресные параметры и типы соединений
Соединение TCP задается указанием локальных и удаленных конечных
точек соединения.

• Локальные адреса:
Локальный IP адрес и локальный порт

• Удаленные адреса:
Удаленный IP адрес и удаленный порт

Соединение
TCP

IP
адрес A

Ethernet узел BEthernet узел A

IP
адрес B

Удаленный
порт

Локальный
порт

Локальный
порт

Удаленный
порт

Рисунок 4–22 Передача и прием по одному соединению TCP

В зависимости от требуемого типа соединения, во время конфигурации
параметры удаленного адреса или указываются или остаются открытыми.

• Заданное соединение TCP
При создании соединения Вы задаете станцию назначения.

• Незаданное соединение TCP
При создании соединения Вы оставляете партнера по соединению
“незаданным”.
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Вкладка Addresses (Адреса) - Заданное соединение TCP
Вкладка Addresses (Адреса) отображает предлагаемые значения для
соответствующих локальных и удаленных адресов. Вы можете
индивидуально изменить значения порта.

Рисунок 4–23 Конфигурация вкладки “Addresses” («Адреса») диалога свойств
    со значениями портов по умолчанию

Порты
Порты или адреса портов определяют точку доступа к программе
пользователя в станции / CPU. Они должны быть уникальными в станции /
CPU!
Следующая таблица показывает диапазоны значений:

Таблица 4–4

Приложение / Замечание Адреса портов
Фиксирован, не должен быть использован! 0
Используются стандартными программами, не должны
использоваться (всем известные порты)

1 - 1024

Используемый NCM диапазон, в котором ищется и
назначается свободный адрес порта.
Вы можете установить любой адрес порта в этом
диапазоне.
Адреса портов больше 5000 используются системой!

от 2000 до 5000



Конфигурирование коммуникационных соединений

4-44 SIMATIC NET NCM для Industrial Ethernet

Вкладка Addresses (Адреса) - Незаданное соединение UDP
Если Вы выберите тип партнера - “незаданный”, то здесь, в зависимости
от Ваших целей, Вы можете ввести адрес партнера по связи. Имеющиеся
параметры подробно объясняются в Разделе 4.4.1.
Вкладка Addresses (Адреса), показанная здесь, отображает ситуацию, в
которой задан удаленный порт, но не задан удаленный IP адрес. Если Вы
не выполните дальнейших вводов, то Вы допускаете, что может быть
установлено соединение с любым партнером по связи, который
использует заданный порт.

Рисунок 4–24
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4.7.3 TCP с режимом FETCH/WRITE

Использование FETCH PASSIVE / WRITE PASSIVE
Если Вы выберите один из следующих двух режимов для соединений
TCP, Вы можете получить прямой доступ к системной области ПЛК
SIMATIC S7 из станции SIMATIC S5 или другой станции не–S7.

Рисунок 4–25

При этом соединение может быть использовано только для этого режима;
передача или прием с FC AG_SEND/AG_LSEND/AG_FSEND или
AG_RECV/AG_LRECV/AG_FRECV больше не возможна.
Установление соединения пассивно; другими словами, только станция
партнер (станция SIMATIC S5 или другая станция не–S7) может
установить соединение. Соответствующие установки во вкладке “General”
(“Общее”) выполняются автоматически и не могут быть изменены.

• FETCH
Выбрав режим FETCH, Вы разрешаете прямой доступ для чтения
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.

• WRITE
Выбрав режим WRITE, Вы разрешаете прямой доступ для записи
системной памяти ПЛК SIMATIC S7 из станции SIMATIC S5 или
станции не–S7.
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Замечание
Помните, что если Вы используйте эту конфигурацию с S7–300, то в CPU
S7–300 используется один ресурс соединения (свободное соединение для
функций S7)! Ресурсы соединения CPU также занимаются, например, при
использовании FMS CP S7-300 или устройством программирования или
OP. Для более подробной информации о максимальном количестве
ресурсов соединения, обращайтесь к /12/ и /6/.

Системная память
Используя FETCH или WRITE Вы можете иметь доступ к следующим
адресным областям системной памяти ПЛК SIMATIC S7:

• Блоки данных (DB)
(При доступе к DB, помните что максимальный номер DB = 255.)

• Битовая память (M, MB, MW, MD)

• Область отображения входов (I, IB, IW, ID)

• Область отображения выходов (Q, QB, QW, QD)

• Область периферии входов (PIB, PIW, PID)

• Область периферии выходов (PQB, PQW, PQD)

• Счетчики (C)

• Таймеры (T)

Подключение к другим системам
Режимы FETCH и WRITE, поддерживаемые по транспортному
соединению ISO и соединению ISO–на–TCP, могут быть также
использованы любым другим устройством другого производителя для
доступа к системной области памяти S7.
Чтобы использовать эти типы доступа (например, для приложений ПК) Вы
должны знать структуру заданий PDU. Требуемые заголовки S7 или S5
для кадров запроса и ответа имеют длину 16 байт, а их структура описана
в Приложение C.
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4.7.4 Проверка свойств соединений TCP

Вкладка Overview (Обзор)
 Вкладка Overview (Обзор) отображает все ранее сконфигурированные
соединения TCP для этой станции и их параметры (только для
информации). Вы можете установить ширину колонок во вкладке
“Overview” (“Обзор”) индивидуально.

Рисунок 4–26 Конфигурация вкладки “Overview” (“Обзор”) диалога свойств

Параметр Описание
Local ID
(Локальный ID)

Это ID соединений TCP

Conn. Name
(Имя соединения)

Введенное имя соединения идентифицирует соединение TCP.

R/S Носитель модулей/слот локального CP, через который установлено
соединение.

Remote Address
(Удаленный адрес)

Задает удаленный IP адрес соединения в подсети Ethernet.

Local port
(Локальный порт)

Локальный порт (длина по умолчанию – 8 символов).

Remote port
(Удаленный порт)

Удаленный порт (длина по умолчанию – 8 символов).

Status
(Состояние)

Состояние отображает текущее состояние конфигурации соединения.
“Соединение без назначение” в колонке состояния отображается как
“No local CP/No remote CP” (“Нет локального CP/Нет удаленного CP”) и
символом “!” в конце “Local ID” (“Локальный ID”) (например: 0002 A000!).
Соединение в состоянии редактирования также помечаются “!” в конце
“Local ID” (“Локальный ID”).

Если в станции S7 Вы используете несколько CPU, Вы можете щелкнуть
по флажку, чтобы увидеть обзор соединений для всех CPU.
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4.8 Конфигурирование соединения UDP

Введение
Помимо добавления в таблицу соединений, Вы также можете изменить
специальные свойства каждого сконфигурированного соединения.
Здесь Вы можете изменить отдельные параметры соединения, которые
были заданы по умолчанию в диалоге "Новое соединение".

Вызов диалога
Чтобы вызвать диалог специальных свойств соединения, следуйте шагам,
показанным ниже:
1. Выберите требуемое соединение в таблице соединений.
2. Выберите пункт меню Edit > Object Properties (Правка > Свойства
объекта)

Результат: появится диалог “Properties UDP Connection” (“Свойства -
Соединение UDP”).

Вкладки
Для соединения UDP доступны следующие вкладки:

• General (Общее)
Отображает общие параметры соединения и локальное имя
соединения UDP.

• Addresses (Адреса)
Отображает информацию о локальном и удаленном адресах.

• Options (Параметры)
Здесь Вы можете сконфигурировать режимы Fast SEND/RECV.

• Overview (Обзор)
Обзор всех сконфигурированных соединений UDP вместе с их
параметрами для выбранной станции S7 и состоянием соединения.
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4.8.1 Задание партнера соединения UDP

Вкладка General (Общее)
Эта вкладка в диалоге свойств отображает параметры соединения и
локальное имя соединения UDP.
Локальный ID идентичен ID в таблице соединений NetPro (STEP 7
конфигурация соединения) и отображается здесь для информации о
присваивании.

Рисунок 4–27 Конфигурация вкладки “General” (“Общее”) диалога свойств соединения UDP
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Атрибуты Описание Доступ
Connection
Конечная точка
(Конечные точки
соединения)
Local ID
(Локальные ID)

Идентичен значению в списке соединений Выбираемо

Name
(Имя)

Предлагаемое имя, которое может быть изменено
пользователем. Для незаданных соединений используйте это
поле для идентификации партнера.

Изменяемо

Via CP
(Через CP)

Если станция содержит несколько CP одного типа,
подсоединенных к одной подсети, Вы можете выбрать маршрут
соединения -> “Route” («Маршрут»), см. Раздел 4.9.
Если нет назначенного CP (например, если CP был ранее
удален), здесь отобразиться “none” («нет»).

Только для
чтения

Block Parameters
(Параметры
блока)
ID Это значение должно быть введено в программе пользователя

как параметр ID вызова блока FC для идентификации
соединения. ID изменяется, если изменяется локальный ID.

Только для
чтения

LADDR Это значение должно быть введено в программе пользователя
как параметр ID вызова блока FC для идентификации
соединения.

Только для
чтения
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4.8.2 Задание адресов UDP

Адресные параметры и типы соединений
Соединение UDP задается указанием локальных и удаленных конечных
точек соединения.

• Локальные адреса:
Локальный IP адрес и локальный порт

• Удаленные адреса:
Удаленный IP адрес и удаленный порт

Замечание
Термин “соединение“ здесь используется также и для UDP. Причина: во
время конфигурирования (например, как и для TCP) коммуникационные
партнеры назначаются друг другу и, таким образом, логически
“соединяются“. На самом деле, для UDP не существует явного
установления соединения между партнерами по связи во время работы.

Соединение
UDP

IP
адрес A

Ethernet узел BEthernet узел A

IP
адрес B

Удаленный
порт

Локальный
порт

Локальный
порт

Удаленный
порт

Рисунок 4–28 Передача и прием по одному соединению UDP

В зависимости от требуемого типа соединения, во время конфигурации
параметры удаленного адреса или указываются или остаются открытыми.

• Заданное соединение UDP
При создании соединения Вы задаете станцию назначения.

• Незаданное соединение UDP
При создании соединения Вы оставляете партнера по соединению
“незаданным”.
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Вкладка Addresses (Адреса) - Заданное соединение UDP
Вкладка Addresses (Адреса) отображает предлагаемые значения для
соответствующих локальных и удаленных адресов. Вы можете
индивидуально изменить значения порта.

Рисунок 4–29 Конфигурация вкладки “Addresses” («Адреса») диалога свойств
    со значениями портов по умолчанию

Порты
Порты или адреса портов определяют точку доступа к программе
пользователя в станции / CPU. Они должны быть уникальными в станции /
CPU!
Следующая таблица показывает диапазоны значений:

Таблица 4–5

Приложение / Замечание Адреса портов
Фиксирован, не должен быть использован! 0
Используются стандартными программами, не должны
использоваться (всем известные порты)

1 - 1024

Используемый NCM диапазон, в котором ищется и
назначается свободный адрес порта.

от 2000…
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Вкладка Addresses (Адреса) - Незаданное соединение UDP
Незаданное соединение UDP может быть использовано двумя путями:

• Свободное соединение UDP
Чтобы сконфигурировать свободное соединение UDP, выберите
флажок “Address assignment in block” (“Задание адреса в блоке”). Тогда
поля ввода для удаленного IP адреса и удаленного порта становятся
неактивными, т.к. назначение адресов теперь выполняется в
программе пользователя.

• Соединение с удаленной станцией из другого проекта
Вы можете задать удаленный IP адрес и порт для любой станции
назначения. Станция назначения может быть в текущем или другом
проекте STEP 7.
Обратите внимание:
Т.к. с UDP (сервис дейтаграмм) не происходит установление
соединения, то обмен данными по сконфигурированному соединению
UDP возможен, только если заданы адреса партнера (IP адрес и порт).
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4.8.3 Проверка свойств соединений UDP

Вкладка Overview (Обзор)
 Вкладка Overview (Обзор) отображает все ранее сконфигурированные
соединения UDP для этой станции и их параметры (только для
информации). Вы можете установить ширину колонок во вкладке
“Overview” (“Обзор”) индивидуально.

Рисунок 4–31 Конфигурация вкладки “Overview” (“Обзор”) диалога свойств

Параметр Описание
Local ID
(Локальный ID)

Это ID соединений UDP

Conn. Name
(Имя соединения)

Введенное имя соединения идентифицирует соединение UDP.

R/S Носитель модулей/слот локального CP, через который установлено
соединение.

Remote Address
(Удаленный адрес)

Задает удаленный IP адрес соединения в подсети Ethernet.

Local port
(Локальный порт)

Локальный порт (длина по умолчанию – 8 символов).

Remote port
(Удаленный порт)

Удаленный порт (длина по умолчанию – 8 символов).

Status
(Состояние)

Состояние отображает текущее состояние конфигурации соединения.
“Соединение без назначение” в колонке состояния отображается как
“No local CP/No remote CP” (“Нет локального CP/Нет удаленного CP”) и
символом “!” в конце “Local ID” (“Локальный ID”) (например: 0002 A000!).
Соединение в состоянии редактирования также помечаются “!” в конце
“Local ID” (“Локальный ID”).

Если в станции S7 Вы используете несколько CPU, Вы можете щелкнуть
по флажку, чтобы увидеть обзор соединений для всех CPU.
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4.9 Маршрутизация

Маршрутизация для распределения нагрузки
Если в станции установлено более одного CP того же типа и они
подсоединены к одной подсети, то можно выбрать маршрут.
Чтобы вызвать диалог маршрута, щелкните по кнопке “Route”
(«Маршрут») во вкладке “General” (“Общее”):

Если Вы для локальной или удаленной станции сконфигурировали
распределение нагрузки на два или более Ethernet CP, то здесь Вы
можете назначить соединению требуемый маршрут через CP.

Параметр Описание
Via CP / Local
(Через CP /
Локальный)

Если в станции, через которую работает соединение, установлено более одного
Ethernet CP, то здесь Вы можете выбрать маршрут.
CP отобразятся для выбора, только если они подсоединены к сети.
Если нет назначенного CP (например, если CP был ранее удален), то здесь
отобразиться “None” («Нет»).
Если в станции установлен только один CP, то выбор не возможен.

Via CP /
Partner
(remote)
(Через CP /
Партнер
(удаленный))

В зависимости от локального выбора отобразятся соответствующие удаленные
CP. Могут быть выбраны любые CP, подсоединенные к той же подсети, что и
локальный CP.
Альтернатива существует, только если соединение установлено с удаленной
станцией, сконфигурированной в этом же проекте, и в ней находятся два или
более CP.
Если у партнера нет назначенного CP (например, если CP был ранее удален), то
здесь отобразиться “None” («Нет»).
Если в удаленной станции установлен только один CP, то выбор не возможен.
Если партнером является “other station” (“другая станция”) или ПЛК SIMATIC S5, то,
в зависимости от ее конфигурации и подключения к сети, для выбора отобразиться
одно соединение или несколько.
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5.1 Общие замечания о FC

Поставляемые FC
Необходимые функциональные блоки (FC) поставляются вместе с
пакетом конфигурирования NCM S7 для Industrial Ethernet.
Следующий список показывает номера поставляемых FC. Вы можете
изменить их номера.

Номер блока FC
5 AG_SEND
6 AG_RECV
7 AG_LOCK
8 AG_UNLOCK
50 AG_LSEND
60 AG_LRECV
51 AG_FSEND1)

61 AG_FRECV1)

Обратите внимание, что FC для SIMATIC S7-400 и SIMATIC S7-300
находятся в библиотеке в разных папках.
1) Эти FC доступны только для S7-400; дополнительную информацию Вы
найдете в Разделе 5.2.

Включение FC в библиотеку STEP 7
Чтобы иметь FC для создания Вашей программы пользователя, следуйте
шагам, показанным ниже:
1. Откройте библиотеку в SIMATIC Manager с помощью File > Open >

Library (Файл > Открыть > Библиотека).
Результат:
Отобразятся существующие библиотеки.

Если записи “SIMATIC NET CP” нет, выполните следующее:
2. Найдите каталог “SIMATIC NET CP” в STEP 7\S7libs и выберите или
откройте файл CP.S7L.
Результат:
В библиотеке STEP 7 будет создана библиотека “SIMATIC NET CP”.

Примеры
Помимо примеров вызовов в этом разделе, Вы найдете примеры, которые
Вы можете сразу использовать, в SIMATIC Manager после установки NCM
S7. Эти примеры описаны в Пример /3/.
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Автоматическое задание параметров блоков
Чтобы гарантировать правильное задание параметров для вызовов блока,
редактор LAD/STL/FBD в STEP 7 предоставляет Вам возможность
перенимать все соответствующие параметры из конфигуратора
аппаратуры (HW Config) и из конфигуратора соединений.
При назначении параметров блока в программе пользователя следуйте
шагам, показанным ниже:

1. Выберите вызов блока и его параметры;

2. Выберите с помощью правой кнопкой мыши команду меню
“Connections…” (“Соединения…”).

3. В зависимости от типа блока Вы теперь можете выбрать из списка
соединение, предусмотренное для блока, или модуля.

4. Подтвердите Ваш выбор; насколько возможно вызову блока будут
назначены доступные значения параметров.

Задание адреса CP
При вызове FC, Вы передаете начальный адрес модуля Ethernet CP в
параметре LADDR (см. /5/).

Определение адреса CP
Начальный адрес модуля можно определить, используя информацию из
/5/ о слотоориентированном назначении адреса для сигнальных модулей.
Информация об аналоговых модулях применима и для Ethernet CP.
При конфигурировании CP с помощью инструмента конфигурирования
аппаратуры S7, в таблице конфигурации отобразиться начальный адрес
модуля.

Выходные параметры FC при запуске CP
При полном перезапуске или перезапуске Ethernet CP (например,
переключателем) выходные параметры FC сбрасываются, как показано:

• DONE = 0

• NDR = 0

• ERROR = 0

• STATUS = 8180H для AG_RECV и 8181H для AG_SEND
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Реакция на неправильную адресацию
Если S7–CPU не может связаться с Ethernet CP используя заданный
начальный адрес модуля, то это приводит к ситуациям, показанным ниже
в таблице.

Замечание
ПЛК SIMATIC S7 адресует Ethernet CP как аналоговый модуль. Это
означает, что если указан неправильный адрес, то возникают сообщения
об ошибках, которые идентифицируются не самими блоками FC.

Причина Реакция / Код
Адрес CP указывает на
несуществующий модуль CP или
цифровой модуль.

CPU остается в состоянии STOP из-за
системной ошибки.

Адрес CP указывает на модуль с
аналоговыми I/O.

Возможные коды ошибок в STATUS:
8184H Системная ошибка
80B0H Модуль не распознает

запись данных.
80C0H Запись данных не читается.
80C3H Ресурсы (память) заняты.
80D2H Неверный логический

базовый адрес.
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5.2 FC для сконфигурированных соединений

Обзор
Для передачи данных по сконфигурированным соединениям существуют
следующие блоки FC:

FC Значение

AG_SEND Для передачи данных <= 240 байт

AG_RECV Для приема данных <= 240 байт

AG_LSEND 1) Для передачи данных

AG_LRECV 1) Для приема данных

AG_FSEND 2) Для передачи данных <= 240 байт

AG_FRECV 2) Для приема данных <= 240 байт

1) Новые версии Ethernet CP могут передавать большие области
данных. Пожалуйста, проверьте длину области данных в
информации о продукте.

2) FC AG_FSEND / AG_FRECV (Fast Send / Receive) предлагают
оптимированную (быструю) передачу данных для станций S7-400.
Чтобы проверить поддерживается ли этот режим используемым
Вами CP, обращайтесь, пожалуйста, к информации о продукте.
Обратите внимание также на замечание по проектированию этого
режима в конце этого раздела.

Применение
Следующий рисунок показывает использование описанных здесь FC для
двунаправленной передачи данных по одному сконфигурированному
соединению.

Соединение

Ethernet CPCPU

Программа
пользователя
STEP7

прием

передача

Области данных
пользователя

AG_RECV

AG_SEND

CPU

AG_RECV

AG_SEND

Ethernet CP

передача

прием

Области данных
пользователя

Программа
пользователя
STEP7
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Замечание
Если это специально не указано, то информация на этой и последующих
страницах относится ко всем блокам AG_SEND / AG_LSEND / AG_FSEND
и AG_RECV / AG_FRECV / AG_FRECV.

Задание области данных в CPU
При вызове FC, Вы передаете адрес и длину области данных в CPU.
Помните, что максимальная длина области данных зависит от типов
используемых блоков.

• AG_SEND / AG_RECV
С этими блоками Вы можете передавать или принимать до 240 байт.

• AG_LSEND / AG_LRECV
Новые версии Ethernet CP могут передавать большие области данных.
Пожалуйста, проверьте длину области данных в информации о
продукте.
Следующая таблица показывает граничные значения для различных
типов соединений.

Таблица 5–1

Транспортное
ISO

ISO-по-TCP TCP UDP

AG_LSEND 8192 байт 8192 байт 8192 байт 2048 байт
AG_LRECV 8192 байт 8192 байт 8192 байт 2048 байт

Замечание
Новыми версиями CP поддерживается передача более 240 байт данных.
За более подробной информацией, обращайтесь к информации о
продукте для Вашего Eternet CP.

Работа без заголовка задания
Для заданных соединений параметры адреса и задания указываются при
конфигурировании соединения. Программа пользователя только
предоставляет данные пользователя в область данных UDP для передачи
с AG_SEND / AG_LSEND / AG_FSEND или приема их с AG_RECV /
AG_FRECV / AG_FRECV.
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Работа с заголовком задания
Свободные соединения UDP требуют заголовка задания в области
данных пользователя.
Следующий рисунок показывает структуру буфера задания и значение и
расположение параметров в заголовке задания.

Заголовок задания

Данные
пользователя

Область данных пользователя

Буфер задания Младший байт Старший байт Байты 0,1
142 11 Байты 2,3
40 35 Байты 4,5

Байт данных 0 Байт данных 1 Байты 5,6
Байты

Байт данных 2041 Байт данных 2042 2047,2048

Порт

IP адрес

Рисунок 5–1 Передача и прием по свободному соединению UDP с программной
адресацией

На рисунке задан следующий IP адрес: 142.11.40.35
Область данных пользователя может быть длиной до 2048 байт. Может
быть передано до 2042 байт данных пользователя. 6 байт
зарезервировано для заголовка задания.

Применение AG_FSEND и AG_FRECV: изменения в проектировании
Если Вы используете FC AG_FSEND или AG_FRECV, Вы должны при
проектировании задать следующую информацию для станций S7-400:
В конфигурировании соединений:
Во вкладке “Options” (“Параметры”) должен быть задан режим FAST
SEND/RECV.
В конфигурировании аппаратуры HW Config:
Во вкладке “Addresses” (“Адреса”) д.б. активирован флажок “Address
setting for FAST SEND/RECV and LOCK/UNLOCK” ("Задание адреса для
FAST SEND/RECV и LOCK/UNLOCK ").

Замечание:
Использование FC AG_FSEND и AG_FRECV и соответствующего
параметра проектирования FAST SEND/RECV имеет только локальное
воздействие; это относится только к оптимизации передачи блоков в
станции S7 между CPU и CP, для которой задан этот параметр. Это не
имеет влияния на обмен данными по LAN. Поэтому на станции партнере
могут быть заданы другие параметры.
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5.2.1 FC-блоки AG_SEND / AG_LSEND / AG_FSEND

Назначение блока
Блок AG_SEND / AG_LSEND / AG_FSEND передает данные в Ethernet CP
для передачи по сконфигурированному транспортному соединению ISO.
Область данных для передачи может быть выбрана из области
отображения процесса, области битовой память или области блоков
данных.
Оповещение об успешном выполнении происходит, если данные были
переданы по Ethernet.

Вызов
Интерфейс вызовов в представлении LAD

ACT

LADDR

DONE

AG_SEND/AG_LSEND/AG_FSEND

ID

SEND

LEN

ERROR

STATUS

BOOL

INT

WORD

ANY

INT

WORD

BOOL

BOOL

Пример в представлении STL

STL Комментраий
call fc 5
ACT := M 10.0
ID := MW 11
LADDR := W#16#0100
SEND := P#db99.dbx10.0 байт 240
LEN := MW 12
DONE := M 10.0
ERROR := M 10.7
STATUS := MW 14

// вызов блока AG_SEND / AG_LSEND

=LADDR 256 dec. в конфигурации аппаратуры

Замечание
Для соединений TCP можно использовать только FC AG_LSEND.
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Как работает блок
Следующий рисунок показывает нормальную последовательность
передачи данных, инициированную в программе пользователя блоком
AG_SEND.
Ethernet CP квитирует каждое задание AG_SEND в программе
пользователя записывая выходные параметры DONE, ERROR и STATUS.

Программа
пользователя

(цикл CPU) Ethernet CP
Коммуникационный

партнер

AG_SEND

0, 0, 81811)

1, 0, 00001)

AG_SEND

Снабжение AG_SEND с
данными “X”

ACT = 1

Передача
“X”
активна на
Ethernet

Обозначение:
1) передача параметров DONE, ERROR,

Время Время Время

Снабжение AG_SEND с
ACT = 0

AG_SEND

0, 0, 81811)

Коды состояния обновляются при каждом вызове блока. Чтобы обновить
коды состояния без новой передачи задания, установите параметр
ACT=0.
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Объяснение формальных параметров
Следующая таблица объясняет все формальные параметры для функций
AG_SEND / AG_LSEND / AG_FSEND.

Параметр Описание Тип Возможные
значения

Примечания

ACT INPUT BOOL 0,1 Если ACT=1, то передается LEN байт из
области данных транспортного ISO, заданной
в параметре SEND.
Если ACT=0, то обновляются коды состояния
DONE, ERROR и STATUS.

ID INPUT INT 1,2...64 (S7–400)
1,2...16 (S7–300)

Номер соединения указывается в параметре
ID (см. проектирование, Раздел 4.4.1).

LADDR INPUT WORD Начальный адрес модуля
Когда CP конфигурируется в
конфигурировании аппаратуры STEP 7, в
таблице конфигурации отобразиться
начальный адрес модуля. Укажите здесь этот
адрес.

SEND INPUT ANY Заданные адреса и длина.
Адрес области данных транспортного ISO,
указывающая на:
- Область отображения процесса
- Битовую память
- Область блоков данных

LEN INPUT INT Для
транспортного
ISO и ISO–по–
TCP:
1 - 8192 (или до
длины, заданной
в параметре
SEND)

Для UDP:
1 - 2048 (или до
длины, заданной
в параметре
SEND)

Число байт для передачи в этом задании из
области данных транспортного ISO. Диапазон
возможных значений: от 1 до длины, заданной
в параметре SEND.
• Обратите внимание на тип блока:

Для FC AG_SEND и AG_FSEND область
данных обычно ограничена до максимум
240 байт.

• Замечание для S7–300:
Передача данных с LEN>240 байт
возможна только, если Ethernet CP был для
это сконфигурирован в диалоге свойств!
(см. Раздел 2.2.5)

• Замечание для S7–400:
Для старых версий CP-микропрограмм
передача данных может быть ограничена
LEN<=240 байт!
Для дальнейшей информации см. /1/

• Улучшенная производительность с
меньшим объемом данных:
Передача объема данных до 212 байт
приводит к улучшению
производительности!
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Параметр Описание Тип Возможные
значения

Примечания

DONE OUTPUT BOOL 0: Задание
активно
1: выполнено

Этот параметр показывает было или нет
задание завершено без ошибок. Пока DONE
= 0, новое задание не может быть запущено.
CP устанавливает DONE = 0, когда он
принимает новое задание.
О значениях этого параметра вместе с
параметрами DONE и STATUS, обращайтесь
к следующей таблице.

ERROR OUTPUT BOOL 0: -
1: ошибка

Бит ошибки
О значениях этого параметра вместе с
параметрами DONE и STATUS, обращайтесь
к следующей таблице.

STATUS OUTPUT WORD см. следующую
таблица

Код состояния
Следующая таблица показывает коды
условий, формируемые параметрами DONE
и ERROR.

Коды условий
Cледующая таблица показывает коды условий, формируемые
параметрами DONE, ERROR и STATUS, которые должны быть
обработаны в программе пользователя.
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Таблица 5–2 Коды условий AG_SEND / AG_LSEND / AG_FSEND

DONE ERROR STATUS Значение
1 0 0000H Задание закончено без ошибки.
0 0 8181H Задание активно.
0 1 7000H Это код возможен только с S7–300: FC был вызван с ACT=0;

задание еще не было обработано.
0 1 8183H Нет конфигурации или транспортные сервисы ISO не были

запущены в Ethernet CP.
0 1 8184H Системная ошибка.
0 1 8185H Параметр LEN больше, чем область источника SEND.
0 1 8186H Недопустимый параметр ID. ID!=1 - 64.
0 1 8301H В станции назначения не активирован SAP.
0 1 8302H Нет приемных ресурсов на станции назначения; принимающая

станция не может обрабатывать принятые данные достаточно
быстро или не приготовила ресурсы для приема.

0 1 8303H Сервис SDA (Send Data with Acknowledge - Передача Данных с
Квитированием) не поддерживается станцией назначения с данным
SAP (на Ethernet нет SDA).

0 1 8304H Соединение не установлено. Передачу задания следует повторить
снова только после ожидания как минимум 100 милисек.

0 1 8311H Станция назначения не доступна по данному адресу Ethernet.
0 1 8312H Ошибка Ethernet в CP; например, короткое замыкание шины,

локальной станции нет в кольце.
0 1 8F22H Неправильная область источник, например:

Область не существует в DB
Параметр LEN < 0

0 1 8F24H Ошибка диапазона при чтении параметра.
0 1 8F28H Ошибка назначения при чтении параметра.
0 1 8F32H Номер DB в параметре слишком большой.
0 1 8F33H Ошибка номера DB.
0 1 8F3AH Область не загружена (DB).
0 1 8F42H Превышение времени при чтении параметра из области I/O.
0 1 8F44H Адрес считываемого параметра блокирован в пути доступа.
0 1 8F7FH Внутренняя ошибка, например, неверная ссылка ANY или параметр

LEN=0
0 1 8090H Нет модуля с данным стартовым адресом или CPU в режиме STOP.
0 1 8091H Начальный адрес модуля вне границы двойного слова.
0 1 80B0H Запись данных не известна для модуля.
0 1 80B1H Неправильная заданная длина (в параметре LEN).
0 1 80B2H Не установлена связь по K-шине между CPU и CP.
0 1 80C0H Запись данных не читается.
0 1 80C1H Указанная запись данных обрабатывается.
0 1 80C2H Слишком много заданий ожидает.
0 1 80C3H Ресурсы (память) заняты.
0 1 80C4H Ошибка связи (возникает временно; часто повтор в программе

пользователя решает проблему).
0 1 80D2H Неправильный начальный адрес модуля.
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5.2.2 FC-блоки AG-RECV / AG-LRECV / AG-FRECV

Назначение блока
Блок AG_RECV / AG_LRECV / AG_FRECV принимает данные из Ethernet
CP, передаваемые по сконфигурированному соединению.
Область данных для приема может быть выбрана из области
отображения процесса, области битовой память или области блоков
данных.
Оповещение об успешном выполнении происходит, если данные были
получены из Ethernet.

Вызов
Интерфейс вызовов в представлении LAD

LADDR

AG_RECV / AG_LRECV/ AG_FRECV

ID

RECV LEN

ERROR

STATUS

INT

WORD

ANY INT

WORD

NDR BOOL

BOOL

Пример в представлении STL

STL Комментарий

call fc 6

ID := DB 100.DBW 1
LADDR := W#16#0100
RECV := P#M 0.0 БАЙТ 100
NDR := DB 100.DBX 0.6
ERROR := DB 100.DBX 0.7
STATUS := DB 100.DBW 2
LEN := DB 100.DBW 4

// вызов блока AG_RECV/AG_LRECV

Замечание
Для соединений TCP можно использовать только FC AG_LRECV.
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Как работает блок
Следующий рисунок показывает нормальную последовательность приема
данных, инициированную в программе пользователя блоком AG_RECV.
Ethernet CP квитирует каждое задание AG_ RECV в программе
пользователя записывая выходные параметры DONE, ERROR и STATUS.

Прием / оценка
принятых данных “A”

Программа
пользователя

(цикл CPU)
Ethernet CP Коммуникационный

партнер

1, 0, 00001)

0, 1, 8180
1)

AG_RECV

AG_RECV

AG_RECV

0, 0, 81801)

1, 0, 00001)

AG_RECV

AG_RECV

Передача
“A”

активна на
Ethernet

Обозначение:
1) передача параметров DONE, ERROR, STATUS

Время Время Время

.

.

.

Передача
“B”

активна на
Ethernet

Передача
“C”

активна на
Ethernet

Прием / оценка
принятых данных “B”

Коды состояния обновляются при каждом вызове блока.
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Объяснение формальных параметров
Следующая таблица объясняет все формальные параметры для функций
AG_RECV / AG_LRECV / AG_FRECV.

Параметр Описание Типы Возможные
Значения

Примечания

ID INPUT INT 1,2...16 Номер соединения указывается в параметре
ID (см. проектирование, Раздел 4.4.1).

LADDR INPUT WORD Начальный адрес модуля
Когда CP конфигурируется в
конфигурировании аппаратуры STEP 7, в
таблице конфигурации отобразиться
начальный адрес модуля. Укажите здесь
этот адрес.

RECV INPUT ANY Заданные адреса и длина.
Адрес области данных транспортного ISO,
указывающая на:
- Область отображения процесса
- Битовую память
- Область блоков данных
Замечание о длине:
Производительность улучшается при
передаче данных объемом до 212 байт, если
Вы также уменьшите длину параметра RECV
до 212.

NDR OUTPUT BOOL 0: -
1: новые данные

Этот параметр показывает были ли приняты
новые данные.
О значениях этого параметра вместе с
параметрами ERROR и STATUS,
обращайтесь к следующей таблице.

ERROR OUTPUT BOOL 0: -
1: ошибка

Бит ошибки
О значениях этого параметра вместе с
параметрами NDR и STATUS, обращайтесь к
следующей таблице.

STATUS OUTPUT WORD см. следующую
таблицу

Код состояния
Следующая таблица показывает коды
условий, формируемые параметрами NDR и
ERROR.

LEN OUTPUT INT Для
транспортного
ISO и ISO–по–
TCP:
1 - 8192
Для UDP:
1 - 2048

Число байт, принятых из Ethernet CP и
занесенные в область данных транспортного
ISO.
• Обратите внимание на тип блока: для FC

AG_RECV и AG_FRECV область данных
обычно ограничена до максимум 240
байт.
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Коды условий
Cледующая таблица показывает коды условий, формируемые
параметрами DONE, ERROR и STATUS, которые должны быть
обработаны в программе пользователя.

Таблица 5–3 Коды условий AG_RECV / AG_LRECV / AG_FRECV

NDR ERROR STATUS Значение
1 0 0000H Приняты новые данные.
0 0 8180H Нет данных.
0 0 8181H Задание активно
0 1 8183H Нет конфигурации или транспортные сервисы ISO не были

запущены в Ethernet CP.
0 1 8184H Системная ошибка.
0 1 8185H Буфер назначения (RECV) слишком мал.
0 1 8186H Недопустимый параметр ID. ID != 1 - 64.

ID != 1 - 16 (S7-300).
ID != 1 - 64.(S7-400)

0 1 8304H Соединение не установлено. Передачу задания следует повторить
снова только после ожидания как минимум 100 милисек.

0 1 8F23H Неправильная область источник, например:
Область не существует в DB.

0 1 8F25H Ошибка диапазона при записи параметра.
0 1 8F29H Ошибка назначения при записи параметра.
0 1 8F30H Параметр защищен от записи в первом активном блоке данных.
0 1 8F31H Параметр защищен от записи во втором активном блоке данных.
0 1 8F32H Номер DB в параметре слишком большой.
0 1 8F33H Ошибка номера DB.
0 1 8F3AH Область назначения не загружена (DB).
0 1 8F43H Превышение времени при записи параметра в область I/O.
0 1 8F45H Адрес считываемого параметра блокирован в пути доступа.
0 1 8F7FH Внутренняя ошибка, например, неверная ссылка ANY.
0 1 8090H Нет модуля с данным стартовым адресом или CPU в режиме

STOP.
0 1 8091H Начальный адрес модуля вне границы двойного слова.
0 1 80A0H Отрицательное квитирование чтения из модуля.
0 1 80A4H Не установлена связь по K-шине между CPU и CP.
0 1 80B0H Запись данных не известна для модуля.
0 1 80B1H Недопустимая область назначения.
0 1 80B2H Не установлена связь по K-шине между CPU и CP.
0 1 80C0H Запись данных не читается.
0 1 80C1H Указанная запись данных обрабатывается.
0 1 80C2H Слишком много заданий ожидает.
0 1 80C3H Ресурсы (память) заняты.
0 1 80C4H Ошибка связи (возникает временно; часто повтор в программе

пользователя решает проблему).
0 1 80D2H Неправильный начальный адрес модуля.
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5.3 FC-блоки для координации доступа с FETCH/WRITE

Обзор
Для координации доступа с функциями FETCH/WRITE используются
следующие FC:

FC Значение
AG_LOCK Блокирует внешний доступ к данным с FETCH/WRITE

AG_UNLOCK Разрешает внешний доступ к данным с FETCH/WRITE

Назначение блока
Если Вы используете FC AG_LOCK и AG_UNLOCK, Вы должны в
конфигурации S7-400 выполнить следующее:
В конфигурировании аппаратуры HW Config:
Во вкладке “Addresses” (“Адреса”) д.б. активирован флажок “Address
setting for FAST SEND/RECV and LOCK/UNLOCK” (“Задание адреса для
FAST SEND/RECV и LOCK/UNLOCK”).

Как работают блоки
С этими FC Вы можете координировать доступ к системным областям
памяти, чтобы не появились и не были переданы противоречивые
данные. Управление осуществляется в программе пользователя CPU S7,
которое, если необходимо, может блокировать внешний доступ с
FETCH/WRITE, используя вызов AG_LOCK. Для разрешения вновь
внешнего доступа по прошествии некоторого времени или по завершении
локального доступа на запись/чтение м.б. использовано задание
AG_UNLOCK.

Другое преимущество в том, что доступ блокируется только для заданного
в вызове соединения FETCH/WRITE. Если сконфигурировано несколько
соединений FETCH/WRITE, то это может быть использовано для
определенной, выбранной области и, таким образом, можно реализовать
выборочную координацию доступа.
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Следующий рисунок показывает нормальную последовательность
координации доступа к памяти, управляемую в программе пользователя
блоками AG_LOCK и AG_UNLOCK.

Программа
пользователя

(цикл CPU)
Ethernet CP Коммуникационный

партнер

Цикл n
AG_LOCK

Активен доступ
FETCH/WRITE

к DB x

Время Время Время

Обработка
данных в DB x

LOCKED = 0

AG_LOCK

LOCKED = 0Цикл n + 1

AG_LOCK

LOCKED = 1

FETCH/WRITE

Отказ FETCH/WRITE

AG_UNLOCK

STATUS = 700x

Цикл n + 2

Цикл n + m

…

Активен доступ
FETCH/WRITE

к DB x

Задание блокирования сначала должно контролироваться в программе
пользователя, используя код возвращаемого параметра LOCKED. Пока
значение LOCKED = 0, подразумевается, что доступ с FETCH/WRITE еще
активен.
Если значение LOCKED = 1, то это показывает, что блокирование активно;
данные могут изменяться программой пользователя.
Коды состояния обновляются при каждом вызове блока.
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5.3.1 FC-блок AG_LOCK

Назначение блока
Используя функцию AG_LOCK блокируется обмен данными по
выбранному соединению с параметром ID с использованием FETCH или
WRITE. Выходной параметр LOCKED показывает выполнилось ли
блокирование или нет. Если блокирование не выполнилось, то задание
д.б. запущено еще раз в следующем цикле CPU.
Выходной параметр STATUS показывает состояние CP для этого
соединения.

Вызов
Интерфейс вызовов в представлении LAD

LADDR

AG_LOCK

ID STATUS

LOCKED

INT

WORD BOOL

WORD

Пример в представлении STL

STL Комментарий

call fc 7

ID := DB 100.DBW 1
LADDR := W#16#0100
STATUS := DB 100.DBW 2
LOCKED := DB 100.DBX 0.6

// вызов блока AG_LOCK
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Объяснение формальных параметров
Следующая таблица объясняет все формальные параметры функции
AG_LOCK.

Параметр Описание Типы Возможные
значения

Примечания

ID INPUT INT 1,2...64 (S7–400)
1,2...16 (S7–300)

Номер соединения указывается в параметре
ID (см. проектирование, Раздел 4.4.1).

LADDR INPUT WORD Начальный адрес модуля
Когда CP конфигурируется в
конфигурировании аппаратуры STEP 7, в
таблице конфигурации отобразиться
начальный адрес модуля. Укажите здесь
этот адрес.

LOCKED OUTPUT BOOL 0: (еще) не
блокирован
1: блокирован

Показывает состояние блокирования
доступа по заданному соединению
FETCH/WRITE.

STATUS OUTPUT WORD см. следующую
таблицу

Код состояния
Для значений см. следующую таблицу.

Коды условий
Cледующая таблица показывает коды условий STATUS, которые должны
быть обработаны в программе пользователя.

Таблица 5–4 Коды условий AG_LOCK

STATUS Значение
7000H CP не обрабатывает задание
7001H Активно FETCH
7002H Активно WRITE
8183H FETCH/WRITE не сконфигурированы для этого соединения
8186H Недопустимый параметр ID. ID != 1 - 64.

ID != 1 - 16 (S7-300).
ID != 1 - 64.(S7-400)
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5.3.2 FC-блок AG_UNLOCK

Назначение блока
Используя функцию AG_UNLOCK разрешается доступ к системным
областям S7 CPU с FETCH или WRITE по соединению, выбранному в
параметре ID.
Теперь м.б. обработано следующее внешнее задание FETCH/WRITE для
CP.
Предварительно доступ блокируется с AG_LOCK.

Вызов
Интерфейс вызовов в представлении LAD

LADDR

AG_UNLOCK

ID STATUSINT

WORD
WORD

Пример в представлении STL

STL Комментарий

call fc 8

ID := DB 100.DBW 1
LADDR := W#16#0100
STATUS := DB 100.DBW 2

// вызов блока AG_UNLOCK

Как блок работает
Чтобы еще раз освободить соединение, FC должен еще раз сбросить бит
запроса LOCK. FC отображает текущее состояние используя сообщения
об ошибке.
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Объяснение формальных параметров
Следующая таблица объясняет все формальные параметры функции
AG_UNLOCK.

Параметр Описание Типы Возможные
значения

Примечания

ID INPUT INT 1,2...64 (S7–400)
1,2...16 (S7–300)

Номер соединения указывается в параметре
ID (см. проектирование, Раздел 4.4.1).

LADDR INPUT WORD Начальный адрес модуля
Когда CP конфигурируется в
конфигурировании аппаратуры STEP 7, в
таблице конфигурации отобразиться
начальный адрес модуля. Укажите здесь
этот адрес.

STATUS OUTPUT WORD см. следующую
таблицу

Код состояния
Для значений см. следующую таблицу.

Коды условий
Cледующая таблица показывает коды условий STATUS, которые должны
быть обработаны в программе пользователя.

Таблица 5–5 Коды условий AG_UNLOCK

STATUS Значение
7000H CP не обрабатывает задание
7001H Активно FETCH
7002H Активно WRITE
8183H FETCH/WRITE не сконфигурированы для этого соединения
8186H Недопустимый параметр ID. ID != 1 - 64.

ID != 1 - 16 (S7-300).
ID != 1 - 64.(S7-400)
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6.1 Обзор

Возможности диагностики в STEP 7
STEP 7 предоставляет Вам разнообразные функции диагностики,
позволяющие Вам получать информацию о состоянии Ваших компонент и
функций SIMATIC S7 и разрешать возникающие в разных ситуациях
проблемы. Эти функции, включают следующее:

Диагностика аппаратуры и поиск неисправностей с STEP 7

Диагностика аппаратуры предоставляет динамическую информацию о
режиме работы модулей (включая CP), подключенной станции S7.

Вы можете узнать о существовании диагностической информации для
модуля по диагностическим пиктограммам в окне проекта SIMATIC
Manager. Пиктограммы диагностики показывают состояние
соответствующего модуля и режим работы CPU.

Подробная диагностическая информация отображается в “module
information” (“информация о модуле”), которую Вы можете вызвать из
быстрого представления или представления диагностики дважды
щелкнув по пиктограмме диагностики.

Диагностика коммуникаций с диагностикой NCM S7

Описываемая здесь диагностика NCM S7 предоставляет динамическую
информацию о рабочем состоянии коммуникационных функций
подключенного CP.

Конфигурация аппаратуры предоставляет статическую
информацию

Статическая информация - это конфигурируемые коммуникационные
свойства подключенного или проектируемого CP, которые Вы можете
отобразить в любое время используя инструмент конфигурирования
аппаратуры HW Config.

Что Вы уже должны знать
Вы должны быть знакомы с базовой информацией из Раздела 2 об
использовании NCM S7. Это означает, что Вы знаете как подсоединить
Ethernet CP к PG и как управлять модулем используя PG.

Где найти дополнительную информацию
Дополнительная информация доступна из следующих источников:

Информация о коммуникационных сервисах находится в
соответствующих разделах этого руководства.

• При работе с инструментом диагностики встроенная справка
предоставляет Вам контексно-зависимую поддержку.

• Вы найдете дополнительную информацию об использовании пакета
STEP 7 во встроенной справке, включающей раздел «Диагностика
аппаратуры».
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6.2 Функции диагностики NCM S7 Ethernet

Функции
Диагностика NCM S7 Ethernet - встроенная компонента дополнительного
пакета NCM S7 для Ethernet.
Доступны следующие функции диагностики:

• Опрос режима работы по Ethernet

• Опрос сообщений о событиях, записанных в Ethernet CP
(диагностический буфер)

• Диагностика транспортных соединений ISO

• Диагностика соединений ISO–по–TCP

• Диагностика соединений TCP

• Диагностика соединений UDP
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6.2.1 Установка и запуск диагностики NCM S7 Ethernet

Установка
Диагностика NCM S7 Ethernet устанавливается на Ваш PG вместе с NCM
S7 для Ethernet.
Вы запускаете инструмент диагностики одним из двух способов:

Properties - CP 443-1- (R0/S4)

Properti Address Diagnosti

NCM  S7-Ethernet Diagnostics

CP Operating Diagnostic Optio

ISO

Interfa

Online
P th

Ether

Waschanl - <Offline> [Project] SIMATIC Manager

Из стандартного меню запуска
Windows 98 / NT из программной
группы SIMATIC.
Используйте этот метод, если на
Вашем PG (используемого для
сервисных целей) нет проекта
STEP 7, в котором был
сконфигурирован данный CP.

Из диалога свойств CP в Вашем
проекте STEP 7.

sinec1\SIMATIC S7-400 - Hardware Configuration

Diagnostic Industrial

Help Industrial

Замечание
Чтобы работать одновременно с диагностикой нескольких соединений, Вы
можете запустить диагностику NCM S7 несколько раз.



Диагностика NCM S7

SIMATIC NET NCM для Industrial Ethernet 6-5

Структура
Диагностика NCM S7 выглядит так же как, например, SIMATIC Manager,
как окно приложения, разделенное на две части, с меню и панелью
инструментов.

Область содержания с
результатами диагностики

С левой стороны, в области навигации Вы увидите иерархически
упорядоченные объекты диагностики.
Вы всегда имеете обзор доступных функций диагностики. Структура
объекта, отображаемая в области навигации, адаптируется в зависимости
от проверяемого в данный момент типа CP и сконфигурированны для него
функций и соединений.
С правой стороны, в области содержания Вы увидите результат
диагностической функции, выбранной Вами в области навигации.

Структура
Вы вызываете функцию диагностики, выбрав с помощью мыши в области
навигации объект диагностики.
Используя строку меню и панель инструментов, Вы управляете
последовательностью диагностики с помощью контекстно зависимых
команд меню.
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6.2.2 Общие кнопки меню

Обзор
При запуске функций диагностики, следующие команды меню имеют
общее значение. В зависимости от контекста м.б. доступны другие
функции; за более подробной информацией обращайтесь к отдельным
темам диагностики.

Таблица 6–1 Значение кнопок меню
Меню Значение

Diagnostics > Open /
Close Online
Connection
(Диагностика >
Открыть / Закрыть
соединение online)

Используя эту команду меню, Вы можете установить соединение с другим
CP, который Вы хотите проверить, не выходя и не перезапуская
инструмент диагностики.
Если Вы хотите одновременно использовать несколько диагностируемых
соединений, Вы можете запустить диагностику NCM S7 несколько раз.

Operating Mode >
(Режим работы)

Вы можете управлять СР следующим образом:

Reset CP
(Очистить СР)

Для некоторых типов СР (например, CP 443-5 Basic) Вы можете очистить
память СР. Эта функция д.б. подтверждена перед тем, как она
выполнится.

Stop CP
(Останов СР)

Останавливает СР

Start CP
(Запуск СР)

Запускает CP, если переключатель RUN/STOP установлен в положение
RUN.

View > Update
(Вид > Обновить)

Каждый раз при вызове этой команды меню обновляется отображаемая
информация о диагностике и состоянии.

View > Update
Cyclically
(Вид > Обновлять
циклически)

Используя эту команду меню, Вы активируете или деактивируете
автоматическое (циклическое) обновление отображаемой информации о
диагностике и состоянии.
Вы можете задать период обновления используя команду меню Options >
Customize (Параметры > Настроить).

Options > Customize
(Параметры >
Настроить)

Используя эту команду меню, Вы задаете общие параметры для сеанса
диагностики.
Для Ethernet:
Dialog Update Time (Период обновления окна)
Устанавливает интервал для обновления данных диагностики в области
отображения, если выбрано циклическое обновление.
Show TSAP in ASCII (Показывать TSAP в ASCII)
Вы можете выбрать использовать ли для отображения TSAP в остальных
диалоговых вкладках шестнадцатиричную нотацию или ASCII

Help
(Справка)

Вы можете вызвать справку gо текущей функции диагностикb. Вы можете
также использовать клавишу F1 или щелкнуть по пиктограмме в панеле
инструментов.
Помните, что для некоторых диалоговых окон Вы также можете вызвать
контекстнозависимую справку. Чтобы вызвать справку, поместите курсор
на поле вывода и нажмите клавишу F1.
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Замечание
Если во время сеанса диагностики прерывается соединение с Ethernet
CP, то выводится следующее сообщение: “The online connection was
terminated” («Соединение прервано»).
Вы можете восстановить соединение с Ethernet CP квитировав
появившийся диалог. Тогда, если это возможно, соединение будет
автоматически восстановлено.
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6.3 Как использовать диагностику

Методика
Чтобы эффективно использовать диагностику, особенно в первый раз,
следуйте следующим рекомендациям.
1. Используйте показанную ниже последовательность в качестве
руководства по сеансу диагностики.

Запустите диагностику NCM S7:
- Установите соединение с СР (Раздел 6.4)
- Выполните соответствующие установки (Раздел 6.2.2)
- Идентифицируйте Ethernet CP (Раздел 6.5)

Опросите текущее состояние CP используя вкладку
“Operating Mode” (“Режим работы”) (Раздел 6.6)

Проверьте/оцените буфер диагностики для обзора или подробного анализа
диагностических событий (Раздел 6.8)

Транспортные соединения ISO
Cоединения ISO-по-TCP
Cоединения TCP
Cоединения UDP
(Раздел 6.7)

Если CP в режиме RUN

Если необходимо скоректируйте конфигурацию или программу.

Если CP не в режиме RUN

Если отображается что-нибудь необычное для:
- статуса соединения
- статуса приема
- статуса передачи

2. Исследуйте Вашу проблему или задачу основываясь, например, на
контрольном списке из Раздела 6.9, и выберите рекомендуемые
функции диагностики.
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6.4 Запуск диагностики - установка соединения с
Ethernet CP

Предпосылки
Установите физическое соединение между PG и станцией SIMATIC S7. Вы
можете выбрать между:

• MPI

• Industrial Ethernet

• Industrial Ethernet TCP/IP

• PROFIBUS

Запуск диагностики из программной группы NCM
Если на Вашем PG/ПК нет конфигурационных данных, то для запуска
диагностики для подсоединенного Ethernet CP следуйте шагам,
показанным ниже:
1. Выберите из группы программ NCM S7 программу “Diagnostics”

(“Диагностика”).
2. В появившемся диалоговом окне “Online Path” ("Online путь") выберите
интерфейс, соответствующий Вашей аппаратной конфигурации.
В зависимости от типа выбранного Вами интерфейса Вы должны
ввести адрес:

Таблица 6–2 Возможные параметры для Online пути - без межсетевых параметров

Соединение со
станцией назначения

Адрес узла Расположение модуля:
носитель модулей / слот

MPI/S7–300 MPI адрес CP, если он имеет свой
собственный MPI адрес.
Иначе, укажите MPI адрес CPU.

№ носителя модулей/слота CP.
Если вы указываете MPI адрес CP,
то Вы можете использовать
значения по умолчанию: «0/0»
С этими установками,
опрашивается CP, с заданным
адресом.

PROFIBUS PROFIBUS адрес PROFIBUS CP,
через который опрашивается
станция.

№ носителя модулей/слота CP.

Industrial Ethernet MAC адрес Ethernet CP станции S7.
Вводится в шестнадцатиричном
формате.

№ носителя модулей/слота CP.
Если Вы укажете “0/0”, то
напрямую опрашивается CP, с
заданным адресом узла.

Industrial Ethernet
TCP/IP

IP адрес Industrial Ethernet CP
Вводится в десятичном формате.
Пример:
IP адрес десятичное 142.120.9.134

№ носителя модулей/слота CP.
Если Вы укажете “0/0”, то
напрямую опрашивается CP, с
заданным адресом узла.
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Межсетевое взаимодействие
Если диагностируемый CP может быть опрошен только через устройство
объединяющее сети, то Вы дополнительно должны выбрать это
устройство и задать его адрес узла в локальной сети.
Вы также должны задать ID подсети S7 сети назначения:
ID подсети состоит из двух чисел, разделенных тире:

- Одно число для проекта
- Одно число для подсети

Вы найдете ID подсети в проекте STEP 7, в свойствах объекта для
подсети. ID подсети также распечатывается вместе с конфигурацией сети.

Запуск диагностики из диалога свойств CP
Если на Вашем PG/ПК присутствуют данные проекта, то следуйте шагам,
показанным ниже:
1. Выберите в проекте станцию S7 и откройте аппаратную конфигурацию.
2. Выберите Ethernet CP и откройте диалог свойств.
3. Выберите вкладку “Diagnostics” ("Диагностика").
4. Щелкните по кнопке “Run...” ("Запуск...").
Результат:
Откроется диалог “Diagnostics” ("Диагностика"). Автоматически
установится маршрут, соответствующий текущему соединению в STEP 7.

Другие возможности запуска
При online подключении к станции S7 Вы можете запустить диагностику
NCM S7 следующим образом:
Из диалога свойств соединения: вкладка “Status Information”
(“Информация о состоянии”) щелкнув по кнопке “Special Diagnostics”
(“Специальная диагностика”)
Из аппаратной конфигурации, используя пункт меню PLC > Module
Information (ПЛК > Информация о модуле) и затем щелкнув по кнопке
“Special Diagnostics” (“Специальная диагностика”)

Замечание
Примеры диалогов, показанные на следующих страницах, применимы и
для транспортного ISO, ISO–по–TCP и UDP.
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6.5 Идентификация Ethernet CP

Цель диагностики
Для идентификации Ethernet CP, к которому подключена диагностика NCM
S7 Ethernet, и для определения текущего режима.

Вызов функции
Вы можете вызвать эту функцию, выбрав в области навигации объект
диагностики “CP Information” ("Информация о CP").

Область содержания и результат диагностики
Отображается следующая информация (значения даны в качестве
примера):
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Таблица 6–3 Параметры в разделе “Online Path” (“Маршрут online”)

Параметр Значение
Interface (Интерфейс) Тип сети, к которой подсоединена станция диагностики.

Address of gateway
(Адрес шлюза)

Если проверяемый СР д.б. опрошен через шлюз, то здесь указывается
адрес узла в локальной сети.

S7 subnet ID of
destination network:
(ID подсети S7 сети
назначения:)

ID подсети состоит из двух чисел, разделенных тире:

- Одно число для проекта

- Одно число для подсети
Вы найдете ID подсети в проекте STEP 7, в свойствах объекта для
подсети. ID подсети также распечатывается вместе с конфигурацией
сети

Address of destination
station network
attachment:
(Адрес подсоединения
станции назначения к
сети:)

Этот адрес может отличаться от проверяемого СР, в зависимости от
выбранного интерфейса.

Rack
(Носитель модулей)

Тип и номер используемого носителя модулей.

Slot (Слот) Номер слота в носителе модулей.

Таблица 6–4 Параметры в разделе “General Module Information” (“Общая информация о
модуле”)

Параметр Значение
CP Type (Тип CP) Идентификатор типа Ethernet CP, например, CP 443–1.

CP Version (Версия CP) Версия микропрограммного обеспечения Ethernet CP

Order Number
(Заказной №)

Идентификатор изделия Siemens - Ethernet CP, который также
используется для выбора модулей программируемого логического
контроллера в конфигураторе аппаратуры S7.

Таблица 6–5 Замечания к параметрам в разделе “Status of Module” (“Состояние модуля”)

Параметр Значение
Operating Mode (Режим работы) и
Cause (Причина):

Возможные режимы:
Stop, Startup, Run.
Возможные причины: OK, команда STOP от PG.

Изменение текущего режима работы
Если Вы хотите изменить текущий режим работы, выберите пункт меню
Operating Mode > Stop/Start CP (Режим работы > Запуск/Останов CP).
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6.6 Опрос режима работы

Цель диагностики
Опрос текущего режима работы Ethernet CP, как модуля в S7–300 и как
узла сети Industrial Ethernet и, если необходимо, изменение его режима
работы (пункт меню Operating Mode > Stop/Start CP (Режим работы >
Запуск/Останов CP)).

Вызов функции
Вы можете вызвать эту функцию, выбрав в области навигации объект
диагностики “Operating Mode” ("Режим работы")

Распознавание состояния СР – значение пиктограмм в области
навигации

CP в режиме RUN

CP в режиме STOP

Область содержания и результат диагностики
Отображается следующая информация:
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Таблица 6–6 Замечания к параметрам

Параметр Значение
Operating Mode (Режим работы)
и Cause (Причина):

Возможные режимы:
Stop, Startup, Run.
Возможные причины: OK, команда STOP от PG.

Status Information
(Информация о состоянии)

По отображаемой информации о состоянии и причине Вы
можете определить тип конфигурации и текущее состояние
сконфигурированных служб.

Memory Resources
(Ресурсы памяти)

Отображается используемый объем памяти Ethernet CP, в
результате конфигурирования, и текущий режим работы.
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6.7 Диагностика соединений:
транспортное ISO / ISO-по-TCP / UDP

Цель диагностики
Для отображения и наблюдения соединений: транспортного ISO / TCP /
ISO–по–TCP / UDP.

Область содержания и результат диагностики
Следующая информация отображается для “ISO Transport”
(“Транспортное ISO”) (значения даны в качестве примера, с другими
типами соединений, экран аналогичен):

Обзор всех используемых типов соединений

Обзор всех коммуникационных соединений
заданного типа, например, все соединения ISO

Информация о состоянии коммуникационного
соединения

Распознавание состояния соединения – значение пиктограмм в области
навигации

Соединение в порядке

Предупреждение: соединение, например, устанавливается

Проблемы по соединению

Соединение разорвано
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Обзор всех используемых типов соединений

Таблица 6–7 Замечания к параметрам в области содержания

Параметр Значение
List of the connections of
all connection types
(Список соединений всех
типов соединений)

Отображаются соединения всех типов соединений без отображения
других параметров.

Обзор всех коммуникационных соединений заданного типа

Таблица 6–8 Замечания к параметрам в области содержания

Параметр Значение
List of connections
(Список соединений)

Для каждого соединения отображается: номер соединения, MAC/IP
адрес партнера и следующая информация:
Sent (pos.): (Послано (пол.):)
Число успешно переданных кадров.
Sent (neg.): (Послано (отр.):)
Число неуспешно переданных кадров
Received (Принято):
Число принятых кадров.

Информация о состоянии коммуникационного соединения

Таблица 6–9 Замечания к параметрам в области содержания

Параметр Значение
Connection properties
(Свойства соединения)

Для каждого соединения отображается: номер соединения, MAC/IP
адрес партнера, локальный и удаленный TSAP и следующая
информация:
Состояние соединения
Состояния приема и передачи и
Состояние шины передатчика

Замечание
Обратите внимание на следующие особые свойства соединений TCP.
Сообщение “Connection established” («Соединение установлено»)
появляется только после того, как был передан один кадр записи или
чтения.
Например, возможно, что соединение TCP не было сконфигурировано на
станции партнере, и тогда сообщение “Connection established”
(«Соединение установлено») никогда не появится. Только после того, как
был передан кадр, можно распознать, что станция партнер не готова.
Только в этом случае экран диагностики можно считать правильным.
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6.8 Диагностика общих ошибок, используя
диагностический буфер

Цель диагностики
Для подробного отображения записанных в Ethernet CP сообщений о
событиях. Диагностический буфер предоставляет Вам полезную
информацию о всех коммуникационных службах Ethernet CP.

Принцип работы
Сообщения о событиях записываются в Ethernet CP в кольцевой буфер,
вмещающий до 50 сообщений.
Однако, в NCM S7 м.б. запомнено до 500 сообщений!
Все функции CP могут генерировать сообщения о событиях. При выборе
этого диалогового окна, считываются и отображаются все сообщения.
Последнее сообщение появляется в верхней строке с наибольшим
номером.

Область содержания и результат диагностики
Отобразиться следующая информация (значения даны в качестве
примера):

Для ISO–по–TCP, TCP и UDP в колонке Event (Событие) указывается
соответствующий тип соединения.
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Таблица 6–8 Замечания к параметрам в диалоговом окне
“Diagnostics Buffer” (“Диагностический буфер”)

Параметр Значение
No.: Последовательный номер сообщения о событиях.

Диапазон значений: в NCM S7 Ethernet м.б. запомнено до 500
сообщений о событиях.
Следующие символы отображают тип:
! = Ошибка
!! = Важная ошибка
Без символа = Информация

Time Stamp: Штамп времени

Function (Функция): Коммуникационные службы, сгенерировавшие сообщение.

Дополнительные функции
Вы можете управлять выводом в диагностическом буфере, используя
следующие дополнительные команды меню:

Кнопка Значение
Diagnostic Buffer > Info on
Entry
(Диагностический буфер
> Информация о записи)

Вы получаете полное, расшифрованное сообщение о
событии в дополнительном окне.

Diagnostic Buffer >
Display New Entries
(Диагностический буфер
> Показать новые
записи)

Если активирована команда меню “Display New Entries”
(«Показать новые записи»), то выводятся новые
сообщения о событиях, возникшие после открытия
диагностического буфера. Если Вы выберите эту команду
меню, то выделяются самые старые из новых сообщения,
и Вы можете легко увидеть, какие сообщения - новые.

Diagnostic Buffer > Delete
Entries
(Диагностический буфер
> Удалить записи)

Все записи в диагностическом буфере NCM S7 удаляются.
При обновлении в списке появляются новые записи.

Замечание:
Это не влияет на записи в Ethernet CP. Записи м.б. опять
считаны в NCM S7 вызвав еще раз диалоговое окно.

Diagnostic Buffer > Save...
(Диагностический буфер
> Сохранить…)

Вы можете сохранить считанные сообщения о событиях
со всеми дополнительными текстами в заданный Вами
текстовый файл (name.txt).
Применение: для сервисных целей.
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Вывод подробного сообщения
Чтобы получить полную, расшифрованную версию сообщения о событии,
следуйте шагам, показанным ниже:
1. Выберите используя курсор соответствующее сообщение о событии из
списка сообщений.
В поле “Decoded Event Message” («Расшифрованное сообщение о 
событии») отображается соответствующая запись для выбранного 
сообщения.

2. Если Вы дважды щелкните по выбранному сообщению о событии или
щелкните по кнопке ”Info” (“Информация”), то появиться текст справки,
объясняющий более подробно сообщение.

Diagnostic Buffer SINEC CP

Meaning:
The SEND/RECEIVE job was rejected since the ISO transport connection is not 
established.

Possible Action:    
Check the Configuration of the ISO transport connection in the local and remote station. 
Check the parameters MAC address, local and remote TSAPO, establishment type 
active/passive.

Additional Information:
Connection ID according to the SEND/RECV block
Level of the entry:  Error
    

SEND /RECEIVE: ISO transport connection

File BookmarkEdit

Content Search Back History

Рисунок 6–1 Пример полного, расшифрованного сообщения об ошибке в окне справки
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6.10 Контрольный список для ‘типичных проблем‘ в
системе

Значение
Следующие списки содержат несколько типичных проблем, их возможные
причины и то, как Вы можете использовать инструмент диагностики NCM
S7 Ethernet для того, чтобы исправить ситуацию.
Вы найдете следующие контрольные списки:
1. Контрольный список для общих функций CP
2. Контрольный список для коммуникационных соединений

Замечание
В колонке “Identifying Cause и Remedy” («Идентификация причины и
мероприятия») Вы увидите рекомендованные функции диагностики.
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6.10.1 Контрольный список для общих функций CP

Таблица 6–9 Контрольный список для типичных проблем при работе CP в установке

Проблема Возможные причины Идентификация причины и
мероприятия

Ethernet CP не
переходит в режим RUN.

В Ethernet CP загружена
неверная конфигурация.

Непрерывно горят желтый светодиод STOP
и красный светодиод SF.
В диагностике NCM S7 Ethernet вызовите
диагностический буфер.
Пример записи:
Превышено максимальное число
транспортных соединений ISO
Дальнейшая запись:
CP перешел в STOP из-за неверного
назначения параметров CP
Что делать:
Скорректируйте конфигурацию Ethernet CP.

Переключатель на
Ethernet CP установлен в
положение STOP.

В диагностике NCM S7 Ethernet опросите
режим работы.

Режим работы: STOP
Причина: переключатель установлен в STOP
Что делать:
Перевести переключатель на Ethernet CP в
положение RUN
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6.10.2 Контрольный список для коммуникационных соединений

Таблица 6–10 Контрольный список для типичных проблем с соединениями:
транспортное ISO / ISO–по–TCP / UDP

Проблема Возможные причины Идентификация причины и
мероприятия

В программе
пользователя не
вызываются AG–SEND и
AG–RECV.
или
Слишком маленький или
неверный буфер приема
или передачи.

Проверьте программу пользователя.
Проанализируйте байт состояния в AG–
SEND и AG–RECV.
Что делать:
Если необходимо, сконфигурируйте блоки
FC.
Если необходимо, скорректируйте указатель
ANY.

Нет передачи данных по
транспортному
соединению ISO /
соединению ISO–по–
TCP или есть только в
одном направлении.

Соединение не
установлено.

Проанализируйте байт состояния блоков FC
или проанализируйте диагностический
буфер.
Что делать:
Измените параметры адреса (MAC/Internet
адрес, TSAP).

Передача данных
слишком медленная

Слишком медленное
приемное устройство

Проанализируйте диагностический буфер.
Запись: “На станции назначения XX нет
ресурсов для приема”.
Что делать:
Замедлите запуск передачи или проверьте
станцию назначения и оптимизируйте прием.

Параметру LEN для AG–
SEND задано неверное
значение.

Что делать:
Задайте параметру LEN требуемую длину.

Передается не весь блок
данных по
транспортному
соединению ISO /
соединению ISO–по–
TCP/UDP.

Буфер, заданный в
указателе ANY, слишком
мал.

Что делать:
Скорректируйте параметр LEN и указатель
ANY.
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Загрузка микропрограмм

7.1 Применение 7–2
7.2 Загрузка микропрограмм 7–4
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7.1 Применение

Микропрограмма
Микропрограммы - это системные программы в SIMATIC NET CP.

Использование загрузчика микропрограмм
Загрузчик микропрограмм позволяет Вам загружать более новые версии
микропрограмм в SIMATIC NET CP. Используется для:

• PROFIBUS CP

• Industrial Ethernet CP

Установка
Загрузчик микропрограмм устанавливается при установке NCM на Ваш
PG/ПК.

Загружаемые файлы
Загрузчик микропрограмм поддерживает следующие типы файлов:

• <файл>.LAD
Тип файла, содержащий только системную программу, загружаемую в
CP.

• <файл>.FWL
Тип файла, содержащий информацию, отображаемую в диалоге
загрузчика микропрограмм в дополнении к типу файла LAD.

Для более подробной информации, читайте файл README,
поставляемый с загружаемым файлом.
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Работа с загрузчиком микропрограмм
В зависимости от типа CP, загрузка подготавливается и выполняется в
три или четыре шага.

Для более подробной информации, обращайтесь к следующему разделу и
диалогам.



Загрузка микропрограмм

7-4 SIMATIC NET NCM для Industrial Ethernet

7.2 Загрузка микропрограмм

Запуск загрузки
Запустите программу из стандартного меню Windows 95/NT: SIMATIC >
NCM S7 > Микропрограмм Loader (Загрузчик микропрограмм).
Выберите кнопку Continue (Далее) и следуйте инструкциям,
отображающимся в диалоге.

Шаг 1
Выберите микропрограмм, которое д.б. загружено, используя кнопку
Browse... (Обзор…).
Текстовое окно выбора файлов показывает также окно списка, в котором
отображаются и могут быть выбраны последние десять использованных
загружаемых файлов.
С загружаемыми файлами FWL окно комментариев может также
содержать дополнительную информацию о файле.

Осторожно
Убедитесь, что используемый Вами загружаемый файл предназначен для
обновления версии микропрограмм, содержащейся в Вашем CP. Если у
Вас есть какие-то сомнения, то свяжитесь с Вашим местным
представителем Siemens.

Шаг 2
Выберите интерфейс, через который Вы хотите загрузить микропрограмм.
Тип интерфейса (PROFIBUS или Industrial Ethernet) уже подразумевается
в выбранном Вами загружаемом файле.

• Для PROFIBUS CP:
В этом диалоге нет дальнейших заданий; переходите к следующему
шагу.

• Для Industrial Ethernet CP:
Выберите или задайте MAC адрес Ethernet CP и переходите к
следующему шагу.

!
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Замечание
Для Industrial Ethernet CP с версией микропрограмм < 2:
Если загрузка была ранее прервана для вышеупомянутого CP, Вы должны
щелкнуть по кнопке Emergency Address (Аварийный адрес). В этом
случае подразумевается, что была проведена очистка памяти CP, и
теперь к нему можно обращаться, только используя аварийный адрес.

Шаг 3
Проверка конфигурации.
Вы можете проверить и скоректировать установки для интерфейса PG/ПК
используя кнопку Modify… (Изменить...).
Задайте интерфейс на Вашем PG/ПК, в соответствии с CP,
установленном в Вашем PG (окно «Module Parameter Sets» (“Задание
параметров модуля”)), и в соответствии с подсоединением к шине (окно
“Properties” (“Свойства”)).
Для более подробной информации, используйте встроенную справку.
Далее, чтобы установить соединение с Ethernet CP, следуйте инструкциям
из диалога.

Осторожно
Помните, что прерывание загрузки может привести к противоречивому
состоянию CP.
Для Industrial Ethernet помните инструкции в Шаге 2 для отображения
аварийного адреса.

Используя кнопку Modify… (Изменить...), Вы можете снова задать
первоначальные значения для интерфейса PG/ПК.
Для более подробной информации обращайтесь к встроенной справке.

!
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B.1 Общая часть
Заголовок кадра Заголовок кадр состоит из идентификатора -> кадра и адреса

источника и назначения.

Кадр Сообщение от одной станции/узла PROFIBUS/Ethernet к другой.

Клиент Клиент это устройство или, в общем значении, объект, который
запрашивает сервисы от -> сервера.

Конфигурационные
данные

Параметры, которые определяют режимы и функции -> CP. Они
задаются и загружаются с использованием инструмента
конфигурирования NCM S7.

Концевик кадра Концевик кадра состоит из контрольной суммы и идентификатора
окончания -> кадра.

Область
отображения
процесса

Области отображение процесса - специальные области памяти в
программируемом логическом контроллере. В начале цикла
программы состояния сигналов модулей входов передается в
область отображения входов. В конце цикла программы область
отображения выходов передается как состояния сигналов на
модули выходов.

Подсеть Подсеть это часть -> сети и ее параметры (например, ->
PROFIBUS) должны ей соответствовать. Она включает сетевые
компоненты и все подсоединенные станции. Подсети могут быть
соединены вместе в сеть с помощью -> шлюзов.
 -> система состоит из нескольких подсетей с уникальными
номерами -> подсетей. Подсеть состоит из нескольких -> станций с
уникальными адресами -> PROFIBUS или MAC (Industrial Ethernet).

Протокол Набор правил для передачи данных. Этими правилами задаются
форматы кадров и потоки данных.

Режим PG Режим PROFIBUS/Ethernet CP, в котором CPU SIMATIC S7
программируется, конфигурируется или контролируется по
PROFIBUS/Ethernet.
Это режим обеспечивается функциями S7.

Сегмент Синоним для -> сегмента шины.
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Сегмент шины Часть -> подсети. Подсети могут состоять из шинных сегментов и
соединяющих устройств, таких как повторители и мосты. Сегменты
прозрачны для адресации.

Сервер Сервер это устройство или, в общем значении, объект, который
обеспечивает определенные сервисы. Сервис запускается по
запросу от -> клиента.

Сервисы Сервисы обеспечиваются коммуникационным протоколом.

Сеть Сеть состоит из одной или более связанных между собой ->
подсетей с любым числом -> станций. Может существовать
несколько сетей.

Скорость передачи Согласно DIN 44302 это число двоичных изменений, передаваемых
за единицу времени. Задание или выбор скорости передачи
зависит от различных условий, например, протяженности сети. В
Ethernet скорость передачи фиксирована и =10 Mbps.

Станция Станция идентифицируется
• MAC адресом в сети Ethernet.

• PROFIBUS адресом в сети PROFIBUS.

Транспортный
интерфейс

Транспортный интерфейс ПЛК SIMATIC S5 обращается к сервисам
транспортного уровня CP, ориентированным на соединение.
Транспортный интерфейс представляется в  управляющей
программе в форме блоков манипулирования данными (HDB).

Транспортный
уровень

Транспортный уровень – это 4 уровень эталонной модели
взаимосвязи открытых систем ISO/OSI. Назначение транспортного
уровня - надежная передача данных от одного устройства к
другому. Транспортное соединение может быть использовано для
передачи.

Установка
(система)

Это означает все электронное оборудование в системе. Помимо
других вещей установка включает: программируемые логические
контроллеры, устройства для обслуживания и наблюдения,
системы шин, периферийные устройства, датчики, линии питания.

Шлюз Интеллектуальное соединяющее устройство, которое соединяет
локальные области -> сети различных типов на 7 уровне ISO.
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CP Communications Processor - Коммуникационный процессор. Модуль
для задач коммуникации.

CSMA/CD Carrier Sense Multiple Access with Collision Detection –
Множественный доступ с контролем несущей и обнаружением
коллизий

FC Логический блок STEP 7 типа “функция”.

Industrial Ethernet Шинная система, соответствующая IEEE 802.3 (ISO 8802-2)

NCM S7 для
Industrial Ethernet

Пакет конфигурирования для конфигурации и диагностики функций
Ethernet CP.

NCM S7 для
PROFIBUS

Пакет конфигурирования для конфигурации и диагностики функций
PROFIBUS CP.

SIMATIC NET Siemens SIMATIC Network and Communication. Имя продукта для ->
сетей и сетевых компонент Siemens (ранее  SINEC).

SIMATIC NET для
Industrial Ethernet

Шинная система SIMATIC NET для промышленного применения,
основанная на Ethernet (ранее SINEC H1)

SINEC Предыдущее имя продукта для -> сетей и сетевых компонент
Siemens. Теперь: SIMATIC NET

TSAP Transport Service Access Point - Точка Доступа к Транспортным
Службам

Watchdog Механизм для контроля работоспособности.
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B.2 Ethernet
Маска подсети Маска подсети задает, какая часть IP адреса назначается для

номера сети (см. ISO–по–TCP). Биты в IP адресе, которые
соответствуют имеющим значения «1» битам в маске
подсети, назначаются номеру сети.

Начальный адрес Логический адрес модуля в системах S7.
• Для PROFIBUS
Начальный адрес PROFIBUS – адрес, начиная с которого в
проекте назначаются все автоматически вычисляемые
адреса.
• Для Industrial Ethernet
Начальный  MAC адрес – адрес, начиная с которого в проекте
назначаются все автоматически вычисляемые адреса.

Номер подсети � установка состоит из нескольких -> подсетей с
уникальными номерами подсетей.

� 

Станция (Industrial
Ethernet)

Станция в сети -> Ethernet (SINEC H1) идентифицируется ->
MAC адресом.

Транспортные
соединения ISO

Коммуникационное соединение транспортного уровня (ранее
с  CP/COM 143 соединение S5S5).
Транспортные соединения ISO позволяют управляемые по
событиям или программно коммуникации по Industrial Ethernet
между ПЛК SIMATIC S7 и
• SIMATIC S7 с Ethernet CP
• SIMATIC S5 с Ethernet CP

(например, CP 143 или CP 1430)
• ПК/PG с Ethernet CP (например, CP 1413)
• Любой системой по транспортному протоколу ISO

(ISO 8073)
Передача блоков данных по транспортным соединениям ISO
- двунаправленная.
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ISO–по–TCP Соединение транспортного уровня (4 уровень коммуникаций
согласно ISO), реализованное по TCP.
По соединению ISO–по–TCP сообщения могут передаваться
в обе стороны. TCP обеспечивает передачу потока данных
без сегментирования данных в сообщения. ISO, с другой
стороны, ориентировано на сообщения. С ISO–по–TCP этот
механизм реализуется по TCP. Это описано в RFC1006
(Request For Comment).
Соединения ISO–по–TCP позволяют управляемые по
событиям или программно коммуникации по Ethernet между
ПЛК SIMATIC S7 и
• ПЛК SIMATIC S7 с Ethernet CP
• ПЛК SIMATIC S5 с Ethernet CP
• ПК/PG с Ethernet CP
• любой системой

MAC Media Access Control – Управление Доступом к Среде.
Механизм для управления доступом станции к общей среде
передачи, разделяемой с другими станциями.

MAC адрес Адрес для распознавания разных узлов, подсоединенных к
общей среде передачи (Ethernet).

RFC 1006 см. ISO-по-TCP

TCP/IP TCP = Transport Control Protocol – Протокол Управления
Передачей; IP = Internet Protocol – Межсетевой Протокол

UDP User Datagram Protocol – Протокол Пользовательских
Дейтаграмм: сервис дейтаграмм для простой межсетевой
передачи без квитировании.



SIMATIC NET NCM для Industrial Ethernet C-1

Связь с другими системами с
FETCH/WRITE

Режимы FETCH и WRITE, поддерживаемые по транспортному соединению ISO и
соединению ISO–по–TCP, могут быть также использованы любым другим устройством
другого производителя для доступа к системным областям памяти S7.

Чтобы использовать эти типы доступа (например, для приложений ПК), Вы должны
знать структуру заданий PDU. Требуемые заголовки S7 или S5 для кадров запроса и
ответа имеют длину 16 байт, а их структура описана в этом разделе.

C
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a) Структура кадров WRITE
Смысл и значения параметров, показанные в следующей таблице без жесткого
назначения, могут быть найдены в разделе “Значения параметров“.

 Кадр запроса WRITE Кадр ответа WRITE
0 Системмный ID =”S” 0 Системмный ID =”S”
1 =”5” 1 =”5”
2 Длина заголовка =16d. 2 Длина заголовка =16d.
3 ID кода OP =01 3 ID кода OP =01
4 Длина кода OP =03 4 Длина кода OP =03
5 Код OP =03 5 Код OP =04
6 Поле ORG =03 6 Поле квитирования =0Fh
7 Длина поля ORG =08 7 Длина поля

квитирования
=03

8 ID ORG 8 Поле ошибки =Nr
9 DBNR 9 Пустое поле =FFh

Начальный адрес Старший
байт

Длина пустого поля =07

B Младший
байт

B

C Длина Старший
байт

C

D Младший
байт

D                свободно

E Пустое поле =FFh. E   
F Длина пустого поля =02 F

          Данные до 64 K
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b) Структура кадров FETCH
Смысл и значения параметров, показанные в следующей таблице без жесткого
назначения, могут быть найдены в разделе “Значения параметров“.

Кадр запроса FETCH Кадр ответа FETCH
0 Системмный ID =”S” 0 Системмный ID =”S”
1 =”5” 1 =”5”
2 Длина заголовка =16d. 2 Длина заголовка =16d.
3 ID кода OP =01 3 ID кода OP =01
4 Длина кода OP =03 4 Длина кода OP =03
5 Код OP =05 5 Код OP =06
6 Поле ORG =03 6 Поле квитирования =0Fh
7 Длина поля ORG =08 7 Длина поля

квитирования
=03

8 ID ORG 8 Поле ошибки =Nr
9 DBNR 9 Пустое поле =FFh

Начальный адрес High Байт Длина пустого поля =07
B Low Байт B
C Длина High Байт C
D Low Байт D                свободно
E Пустое поле =FFh. E   
F Длина пустого поля =02 F

Данные до 64 K, только
если поле ошибки =0
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Значения параметров

Область адресов S7 DB M I Q
ORG ID 01H 02H 03H 04H

Данные
источника /
назначения
из/в блока
данных в
основной
памяти

Данные
источника /
назначения
из/в области
флагов

Данные
источника /
назначения
из/в области
отображения
входов (PII)

Данные
источника /
назначения
из/в области
отображения
выходов
(PIQ)

DBNR DB, из
которого
берутся
 данные
источника
 или в
который
записываютс
я данные
назначения

Не имеет
значения

Не имеет
значения

Не имеет
значения

Возможный диапазон 1...255
Начальный адрес Номер DW,

из которого
берутся или в
который
записываютс
я данные

Номер байта
флагов, из
которого
берутся или в
который
записываютс
я данные

Номер байта
входов, из
которого
берутся или в
который
записываютс
я данные

Номер байта
выходов, из
которого
берутся или в
который
записываютс
я данные

Возможный диапазон 0...2047 0...255 0...127 0...127
Длина Длина поля

данных
источника /
назначения в
словах

Длина поля
данных
источника /
назначения в
байтах

Длина поля
данных
источника /
назначения в
байтах

Длина поля
данных
источника /
назначения в
байтах

Возможный диапазон 0...2048 0...256 1...128 1...128

“Длина“ может быть также задана = -1 (=FFFFH). Тогда CP с FETCH передает
“оставшуюся длину” области чтения. CP с WRITE принимает столько данных, сколько
содержится в кадре данных пользователя.
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Область адресов S7 PIW, PIB, PID/
PQW, PQB, PQD

C T

ORG ID 05H 06H 07H

Данные источника
/ назначения из/в
модуля I/O. Для
данных источника -
входы, для данных
назначения –
выходы

Данные
источника /
назначения
из/в ячейки
счетчика

Данные
источника /
назначения
из/в ячейки
таймера

DBNR Не имеет значения Не имеет
значения

Не имеет
значения

Начальный адрес Номер байта I/O,
из которого
берутся или в
который
записываются
данные

Номер ячейки
счетчика, из
которой
берутся или в
которую
записываются
данные

Номер ячейки
таймера, из
которой
берутся или в
которую
записываются
данные

Возможный диапазон 0...127
цифровые I/O
128...255
аналоговые I/O

0...255 0...255

Длина Длина поля
данных источника /
назначения в
байтах

Длина поля
данных
источника /
назначения в
словах (ячейка
счетчика = 1
слово)

Длина поля
данных
источника /
назначения в
словах (ячейка
таймера = 1
слово)

Возможный диапазон 0...256 1...256 1...256

“Длина“ может быть также задана = -1 (=FFFFH). Тогда CP с FETCH передает
“оставшуюся длину” области чтения. CP с WRITE принимает столько данных, сколько
содержится в кадре данных пользователя.
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SIMATIC NET - Поддержка и обучение

SIMATIC Training Center – Центры обучения
Чтобы помочь Вам познакомиться с программируемыми логическими контроллерами
SIMATIC S7, мы предлагаем курсы обучения. Свяжитесь, пожалуйста, с Вашим
местным центром обучения или центральным центром обучения по адресу: D 90327
Нюрнберг. Информационная линия:
тел. 0180 523 5611 (48 Pfg./мин.), факс: 0180 523 5612
Internet: http://www.ad.siemens.de/training

E-mail: AD–Training@nbgm.siemens.de

SIMATIC Customer Support Hotline
Доступен круглые сутки:

Johnson City

Nuremberg

Singapore

Simatic Basic Hotline

Нюрнберг
SIMATIC BASIC Hotline

Johnson City
SIMATIC BASIC Hotline

Сингапур
SIMATIC BASIC Hotline

Местное время:
Пн.–Пт. 8:00 - 18:00
Телефон: +49 (911) 895–7000
Факс: +49 (911) 895–7002
E–mail: simatic.support@

nbgm.siemens.de

Местное время:
Пн.–Пт. 8:00 - 18:00
Телефон: +1 423 461–2522
Факс: +1 423 461–2231
E–mail: simatic.hotline@

sea.siemens.com

Местное время:
Пн.–Пт. 8:30 - 17:30
Телефон: +65 740–7000
Факс: +65 740–7001
E–mail: simatic@

singnet.com.sg

SIMATIC Premium Hotline
(платно, только с
SIMATIC Card)
Местное время:
Пн.–Пт. 0:00 - 24:00
Телефон: +49 (911) 895–7777
Факс: +49 (911) 895–7001

D
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SIMATIC Customer Support интерактивные сервисы
SIMATIC Customer Support предоставляет Вам широкий диапазон дополнительной
информации по продуктам SIMATIC в интерактивных сервисах:

• Вы можете получить общую актуальную информацию:
- в Internet: адрес http://www.ad.siemens.de/csi/net
- по факсу: 08765–93 02 77 95 00

•  последняя информация о продуктах и полезные загружаемые данные:
- В Internet: по адресу http://www.ad.siemens.de/csi/net
- Из электронной доски объявлений (BBS) в Нюрнберге (SIMATIC

Customer Support Mailbox) по номеру +49 (911) 895–7100.
Чтобы связаться с почтовым ящиком, используйте модем до
V.34 (28.8 КБод), со следующими параметрами: 8, N, 1, ANSI, или
соединение по ISDN (x.75, 64 КБит).

Дальнейшая поддержка
Если у Вас есть дальнейшие вопросы по продуктах SIMATIC NET, связывайтесь с
Вашим местным представительством Siemens.

Вы найдете адреса:

• в нашем каталоге IK 10

• в Internet (http://www.ad.siemens.de)
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